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Board Meetings

Open to all members. Call  
935-6690 for further information.

Memberships
S.V.C.G. Annual Membership: $20.
S.V.C.G. Family membership: $30 (re-
siding at same address). Membership renewals 
are due and payable at the beginning of each 
year.

General Meetings
S.V.C.G. meets second Saturday 
of each month at Sonoma Public 
Library, 755 West Napa Street; 
HOURS: Mac: 9AM-10:30AM, 
Windows: 10:30AM-noon unless 
otherwise notified. Meetings free; 
guests welcome.

About this publication
Sonoma Valley Computer Group Newsletter is pub-
lished monthly by Sonoma Valley Computer Group. 
Desktop publishing services donated by: Kathy 
Aanestad. Call: (707) 935-6690, email aanestad@

vom.com. © 2009, SVCG. All rights reserved. 
Sponsored by our local ISP, DataProfessionals, on 

19480-8th St. East. 

Donating Used Computer Equipment

The URL listed is for the Computer Recycling Center. All of the info 
needed (and then some) is listed on the site. 
http://www.crc.org/

SVCG User Group Benefits & Discounts

O’REILLY
Members receive a 20% discount on  O'Reilly books and conferences. 
Contact Kathy for the code.
 
New Riders  Books
http://www.newriders.com
BECOME A NEW RIDERS CLUB MEMBER. You can save up to 
20% on all books every day at newriders.com simply by becoming a 
New Riders Club Member. Membership is free and easy. All you have 
to do is answer a few, short questions in our ongoing, online survey, 
which you can access on any book page. Don't worry.

All of your information stays with us--we won't sell it or give it away 
to anyone. After you've filled out the profile, you'll save 20% automati-
cally whenever you log on to http://www.newriders.com as a member. 
It's that easy!

Note that you may use your User Group Coupon Code ON TOP of 
your Club Member savings.  Just remember to log in first when making 
a purchase and then enter the code at checkout as well! Contact Kathy 
for code.

PEACHPIT



SEPTEMBER MEETING
☞ GUEST SPEAKER ☜

Want to learn about FACEBOOk, MySPACE, or TWITTER? 
Then September’s meeting is for you. Invite a friend.

Guest speaker, Bruck Kolman, will take us throug the 
steps and show us how, for example, set up a Facebook 
account.
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SVCG
Plugged into Technology ( ;

JOIN THE PEACHPIT CLUB
 You can save 30% on all books every day at peachpit.com simply by becoming  a Peachpit Club Member. Mem-
bership is free and easy. All you have to do is  answer a few, short questions in our ongoing, online survey, which 
you can  access on any book page. Don't worry, all of your information is confidential  and stays with us--we won't 
sell it or give it away to anyone. After you've  filled out the survey, you'll save 30% automatically whenever you 
log on  to http://www.peachpit.com as a  member. It's that easy!

USER GROUP COUPON CODE
 User group members should note that once you've become a Peachpit Club member,  you may use your user 
group coupon code ON TOP of the permanent savings you  earn as a member of the club. Just make sure you've 
logged onto the site  before you make a purchase to ensure this permanent discount will be in effect,  then enter 
coupon code (case-sensitive) at checkout! This coupon  code is an exclusive offer that may not be used in con-
junction with any other  coupon codes. Contact Kathy for code information.

NO AUGUST 
MEETING



Sonoma Valley Computer Group Membership Application/Renewal Form

New Applicant ___	 Renewal ___

Name:_______________________________	
Address:_ ____________________________
____________________________________
Home Phone:__________________________
Work Phone:__________________________
E-mail Address:________________________
Send __ $20 (individual) __ $30 (family) check to:
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 ___ I give permission to use this info in the club 
roster which is for members only

Platform:	
__Mac            __PC   
__WinXP       __Win98	
__WinVIsta     __OS Leopard     __OS Tiger	  __OS X
 __Linux		             
	
Computer Make/Model:____________________	

How did you hear about SVCG?
__class  ___club member  ___newspaper  ____newsletter

User Level:	 __	 Novice	 __	 Intermediate
	 __	 Advanced	 __	 Expert

Sonoma Valley Computer Group
POB 649
El Verano, CA 95433

YOU MAKE A DIFFERENCE

This is your August -  
September newsletter.

Note: There will be NO August SVCG 
meeting. We’re taking a break!

SVCG will resume September 12th.
We are very excited to present our guest 

speaker, Bruce Kolman, who will talk 
about Social Networking - FACEBOOK, 

TWITTER, MYSPACE, and more. 

Bring your questions.
See you September 12th. 

Mark your calendars and remember —
 invite a friend.



Mac Radio, on your iPod/iPhone
by Bruce Kolman

I have a 50 minute com-
mute from Windsor to 
Sonoma every day. Since 
I had long since given 
up on the radio, my iPod 
has become my ever con-
stant traveling compan-
ion. When Apple added 
podcasts to iTunes, I was 
saved. Since I have a va-
riety of interests I have 
been able to find pod-
casts to fill every day of 
the week, both ways. 

I am first and foremost an 
Apple enthusiast and have 

been since my Apple IIc. While some fathers and sons 
talked sports, my father and I talked Macs (and sports). 
There is a plethora of Mac related podcasts, some pro-
duced right here in Sonoma County. If you like hearing 
your  Mac information as well as reading about it in Mac-
world or Mac Life, I have some podcasts for you. Most 
of these shows cover both the Macintosh world as well 
as iPod/iPhone topics including both hardware and soft-
ware. You can listen on your computer, iPod or iPhone. 
The advantage is that unless you scour the blogs your-
self, you can’t get your information any faster. Maga-
zines come out monthly, while these shows are produce 
weekly. Both Macworld and Mac Life offer fine pod-
casts with news and reviews of all things Apple, however 
there are a variety of podcasts that can cover your need 
for Mac information.

The quick and dirty news roundup can be found on 
Mac OS Ken. Ken Ray reads the news from around the 
blogosphere in an entertaining and concise fashion. This 
podcast is actually released five times a week. He also 
has a weekly paid program, Mac OS Ken Day 6, which 
is a longer form program with interviews and more in-
depth reviews. You can find Ken on iTunes or at www.
macosken.com .

The Typical Mac User focuses on how-
to’s for beginners as well as novice users, 
while The Power Mac User podcast of-
fers how to’s for more advanced users. 
There are several podcasts that have one 
or two hosts covering “all things Apple”. 
Some of the best of these include the 
Mac Core and The Mac Cast. The Mac 
Roundtable is a rotating collection of 
podcasters that meet online via Skype 
which offers a wide range of opinions on 
current goings on in the Mac world. Most 
of these are not professional broadcast-
ers, but fellow enthusiasts who have 
harnessed the power of their Macs and 
produce these shows every week. They 
are all informative and entertaining.

I must say that my favorite of all these 
podcasts is  MacBreak Weekly. It is 
produced by Leo Laporte (aka The Tech 
Guy on am radio), right here in Peta-
luma. It features Leo, Andy Ihnatko, 
Scott Bourne, and Alex Lindsay talking 
about the weeks Mac news, as well as 
offering software and hardware picks of 
the week. This show is very well pro-
duced and most reminds me of those 
Mac conversations with my father, and 
now my mother who has become quite 
the geek in her own right. Leo also pro-
duces several other podcasts on a va-
riety of tech topics on the TWIT (This 
Week in Technology). You can find out 
more about these shows at www.twit.
tv. Scott and Andy also host a podcast 
called MYDL, or Managing Your Digital 
Life (www.mydl.me).This podcast fo-
cuses mostly on what to do with all of 
your digital media files. Topics include 
storage, back-up, and the many types of 
media and devices you can use to man-

GUEST COLUMNIST
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age your digital life.

All of these shows can be subscribed to via iTunes, 
and best of all they are free. I am grateful to all of 
these fine podcasters for keeping me awake and in-
formed during my sojourn to and from work. I hope 
you find them useful and that they help you get more 
out of your Macs. 

✌

Mac Tip of the 
Week #232
Excerpted from The iPhone Pocket Guide, Third Edition by 
Christopher Breen

Sync Your iPhoto Pictures with Your 
iPhone
If you’re a Mac user and you store your pictures in iPhoto, 
you’re probably aware that iPhoto automatically groups pic-
tures taken during the same general period—a single day, for 
example. In the Photos tab within iTunes, you can ask that 
iPhoto’s 1, 3, 5, 10, or 20 most recent events be synched to 
your iPhone.

$1.23 Billion 
Profit Highlights 
Apple’s Q3 2009
-----------------------------------------------
 by Jeff Carlson <jeffc@tidbits.com>
 article link: <http://db.tidbits.com/article/10422>

 Apple reported “record non-holiday quarter revenue and 
earnings” for the third quarter of its fiscal 2009, boasting a 
profit of $1.23 billion on revenue of $8.34 billion, or $1.35 
per diluted share. (Those numbers compare to a profit of 
$1.07 billion on revenue of $7.64 billion in the year-ago 
quarter.) The results were bolstered by strong sales of lap-
tops, iPhones, and the iPod touch, even as sales of traditional 
iPod models declined. (For accounting purposes,
 Apple’s year ends 27-Sep-09.)

<http://www.apple.com/pr/library/2009/07/21results.
html>

 Apple sold 2.6 million Macs, up from 2.2 million 
in the second quarter of 2009. The company doesn’t 
report sales by model type, but in its quarterly earn-
ings conference call, Chief Financial Officer Peter 
Oppenheimer said that portables are now two-thirds 
of all Mac sales. The entire MacBook lineup was re-
freshed in June, which accelerated sales according to 
Oppenheimer (see “Apple Refreshes MacBook Line at 
WWDC,” 2009-06-08).

<http://db.tidbits.com/article/10332>

 The iPhone, not surprisingly, was a strong perform-
er. Apple sold 5.2 million iPhones during the quarter, 
though Apple didn’t reveal how that number breaks 
down into iPhone 3G and iPhone 3GS sales. However, 
Oppenheimer said that the company can’t yet make 
iPhone 3GS units fast enough to fulfill demand. Chief 
Operating Officer Tim Cook also noted that almost 
20 percent of Fortune 100 companies have purchased 
10,000 or more iPhones, while some large corporations 
and government organizations have bought more than 
25,000 units each. Because Apple accounts for iPhone 
(and Apple TV) revenue over the course of the devic-
es’ estimated lives, the revenue figures don’t include 
all money from actual sales. The non-GAAP (General-
ly Accepted Accounting Principles) results - money ac-
tually coming in - shows a $1.94 billion profit on rev-
enue of $9.74 billion. It’s also worth noting that Apple 
didn’t recognize iPhone revenue between 17-Mar-09 
(when the iPhone OS 3.0 was announced) and 17-Jun-
09 (when the software was released).

 The iPod touch was particularly popular during the 
quarter, growing 134 percent over last year. However, 
the gains were offset by declining sales of other iPod 
models, leading to overall sales of 10.2 million iPods, 
a 7 percent decline from the previous year’s quarter. 
The company expects iPod touch sales to increase in 
the fourth quarter, an indication that the device will be 
updated (iPods have traditionally seen updates in that 
time period).
 ----
 read/post comments: <http://db.tidbits.com/article/
10422#comments>
 tweet this article: <http://db.tidbits.com/t/10422>
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Eye TV
http://www.elgato.com/elgato/na/mainmenu/products/hy-
brid09/product1.en.html

EyeTV is sold by El Gato http://www.elgato.com/ and is ba-
sically a stable of devices that allow you to view and record 
TV on your computer. Some of their devices 
can also digi- tize vhs video 
tapes. The device and 
s o f t - ware can 
w a k e y o u r 
c o m - p u t e r 
f r o m sleep to 
record a program 
and then put it back to 
sleep, either as a one-time event or 
on a schedule. The recordings can then be exported to a 
multitude of devices (it’s fully compatible with anything 
Mac) and burned to dvds. I’m just a bit rusty on the burning 
end and wanted 16:9 format with best viewing.

	 The nice and fun thing about EyeTV is that the 
viewing window can be full screen or infinitely resized and 
positioned like any Mac window so you have no excuses 
not to do your work because A Few Good Men is on again 
(I’ve seen it 25+ times and can recite the lines) or the finish 
of the Tour de France. You can even drag a running TV win-
dow into the doc and it will play as a tiny little icon there 
with sound. 

	 In the past you could use EyeTV with an analog an-
tenna but now that we’re all digital TV you would have to 
hook it to your digital converter box or, like I do, to your 
cable to get a signal.

What their website says:

Watch HDTV, analog TV, and FM radio on your Mac

EyeTV Hybrid 
turns your Mac 
into the world’s 
most afford-
able flat-screen 
HDTV. And be-
cause it receives 
both unencrypt-
ed analog and 

digital TV, EyeTV Hybrid is an ideal solution for 
the digital transition. Continue to watch analog 
cable TV on your Mac, and use your antenna to 
receive crystal clear HDTV broadcasts as soon as 
they become available in your area. What’s more, 
EyeTV Hybrid receives FM radio.
Record television for your iPod, iPhone & Apple 
TV

But EyeTV Hybrid does more than just TV. Thanks 
to the included EyeTV 3 software, EyeTV Hybrid 
is also a digital video recorder (DVR) with a com-
prehensive Program Guide and editing capabilities. 
It’s a DVR that can put your television recordings 
on a Mac, iPod, iPhone, or Apple TV with one easy 
click of a button, and can export them for use in 
other Mac video applications. All this, in one small 
TV tuner stick.

Digital Photography 
Book, Volume 3, The

 By Scott Kelby
 Published Jul 21, 2009 
by Peachpit Press.
Your Price: $24.99
Copyright 2010
 Dimensions 6 X 9
 Pages: 264
 Edition: 1st.
 ISBN-10: 0-321-61765-
7

Scott Kelby, author of The Digital Photography 
Book, volume 1 (the world’s best-selling digital 
photography book of all time), is back with a fol-
low-up to his volume 2 smash best seller, with an 
entirely new book that picks up right where he left 
off. It’s even more of that “Ah ha—so that’s how 
they do it,” straight-to-the-point, skip-the-techno-
jargon stuff you can really use today to make your 
shots even better.

This book truly has a brilliant premise, and here’s 
how Scott describes it: “If you and I were out on 
a shoot and you asked me, ‘Hey Scott, I want the 
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light for this portrait to look really soft and flattering. How 
far back should I put this softbox?’ I wouldn’t give you a 
lecture about lighting ratios, or flash modifiers. In real life, 
I’d just turn to you and say, ‘Move it in as close to your 
subject as you possibly can, without it actually showing 
up in the shot.’ Well, that’s what this book is all about: 
you and I out shooting where I answer questions, give you 
advice, and share the secrets I’ve learned, just like I would 
with a friend—without all the technical explanations and 
techie photo speak.”

Each page covers a single concept on how to make your 
photography better. Every time you turn the page, you’ll 
learn another pro setting, tool, or trick to transform your 
work from snapshots into gallery prints. If you’re tired of 
taking shots that look “okay,” and if you’re tired of look-
ing in photography magazines and thinking, “Why don’t 
my shots look like that?” then this is the book for you.

This isn’t a book of theory—full of confusing jargon and 
detailed concepts. This is a book on which button to push, 
which setting to use, and when to use it. With nearly 200 
more of the most closely guarded photographic “tricks of 
the trade,” this book gets you shooting dramatically better-
looking, sharper, more colorful, more professional-look-
ing photos every time.

Mac Tip of the 
Week #230
Excerpted from Apple Training Series: iLife ‘09 by Mi-
chael E. Cohen et al.

Search iPhoto by Keyword
If your photos in iPhoto have keywords assigned, you 

can search for the files associ-
ated with particular keywords. 
1) Choose Keyword from the 
search field’s pop-up menu. The 
Keywords pane appears. 2) In the 
Keywords pane, click the desired 
keyword. The photos with that 
keyword assigned appear in the 
viewing area.

Mac Tip of the 
Week #227
Excerpted from The Macintosh iLife ‘09 by Jim Heid

Naming a Face in iPhoto
When iPhoto scans your 
photos for faces, it’s 
simply identifying pho-
tos that it thinks con-
tains eyes, noses and 
mouths. It’s up to you 
to tell iPhoto who those 
folks are—a process 

called Naming a Face.

Step 1. Select a photo containing a face you want to 
name.

Step 2. Click the Name button. The photo appears with 
a box enclosing each face.

Step 3. Click the unnamed face text, type the person’s 
name, and then press the Return key. If the photo con-
tains additional unnamed faces, repeat this step to name 
each face. To move to different photos and name the 
faces they contain, click the arrow buttons. Are you 
done naming? Click Done.



Still Afraid of Social Networks? Top 4 Objections 
and How to Disappear Them
by Julia D. Stege, MFA
@magicalmarketer

I have been giving a lot of talks and classes lately on 
Social Networking and I’ve been getting some feed-
back from folks that they’re still afraid of the likes 
of Twitter and Facebook. There are so many reasons 
people have for avoiding these free online marketing 
tools. The ones I hear the most are:

1. I will lose my privacy.
2. I don’t have the time to do one more thing.
3. People say meaningless things like what they’re 
eating. Why do I care?
4. I don’t understand how to use Social Networks to 
attract perfect customers.

I promise you, I feel your pain. I really do. There 
was once a time when I said all of these things about 
sites I now use daily to grow my list, create buzz 
about my offerings, and expand my reputation on-
line. But instead of giving up, I investigated, spent 
time, learned, and used the social networks to great 
advantage. And even though everyone is talking 
about Twitter and Facebook now, most Internet mar-
keters weren’t even on these sites a few months ago. 
So relax! Everyone is new at this. And I’ll give you 
some tips to disappear those objections you may still 
have to Facebooking and Tweeting your way to In-
ternet marketing success.

Objection 1: I’ll lose my privacy.

Frankly, my gut reaction to this objection is, “pri-
vacy is dead.” Anyone who markets online is expos-
ing themselves to the world in bigger ways than ever 
was possible before. There are great advantages to 
being this exposed, including improved reputation, 
expanded influence, and wider selection of potential 

Sonoma Valley Computer Group Newsletter	 9	 http://www.vom.com/svcg/index.html

customers. My second reaction is, “what do you 
have to hide?” I always promote an authentic ap-
proach to marketing because your most perfect 
customers are attracted to your true self. Social 
Networks offer your contacts an opportunity to get 
to know the real you, and if they don’t like you, 
they’re not your perfect customers! That said, it’s 
a good idea to keep your personal information pri-
vate, such as your personal email, home phone, and 
other info, if you don’t want folks contacting you 
night and day. Create business contact avenues that 
you can turn off when the business day ends.

Objection 2: I don’t have the time to do one 
more thing
Let me offer a scenario. Everyone in business needs 
to network to spread the word about their offerings 
and meet new contacts. How much time does it 
take to go to one networking meeting? Consider 
you have to get dressed up which takes about an 
hour, and then you must get to the event, say anoth-
er half hour. The event is 2-3 hours, and then you 
have to drive home. That’s a total of 4 - 5 hours! If 
you were to spend that time networking online you 
have the potential to reach a much larger audience, 

STILL AFRAID OF SOCIAL 
NETWORKING?
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and your web properties will stay up for months or even 
years attracting your customers 24/7.

Objection 3: People say meaningless things like what 
they’re eating. Why do I care?

This is a common complaint. You go to your network and 
feel inundated by nonsense. Here’s a tip: If you don’t like 
what people are writing about on your networks, you’re 
not connecting to the right people. To attract the right 
people, do a keyword search using words that reflect your 
purpose and interests and connect with them! Search for 
groups of like minded people and friend them. After a 
while you’ll find your networks filled with helpful tidbits 
and inspirations that uplift and educate you. Spend some 
time responding to those folks who have said something 
interesting and encourage them. Make sure you offer 
helpful and interesting information too, so it’s not just a 
one way relationship!

Objection 4: I don’t understand how to use Social 
Networks to attract my perfect customers.

You’re not alone! Most people know how to have fun, 
connect, and chat with folks online once they get the 
hang of it, but attracting customers? That’s a different 
story. Consider this: Dale Carnegie who wrote How to 
Win Friends and Influence People taught us that people 
will buy from us when they know us, like us and trust us. 
Making friends online is a crucial step in this process. 
The second step is in creatively letting them know about 
what you’re offering for sale, and be authentic.

I realize it’s not that simple for some folks who need a 
helping hand. That’s why I teach a 10 week program for 
conscious entrepreneurs who need guidance through the 
process of getting on the right social networks, using the 
right words to attract folks, and using the best tools to 
create new business relationships. I also offer free tele-
classes once per month to give you some valuable tips on 
how to get started on the Social Networks. Visit http://
www.graphicgirlz.com/apco.html to learn more and reg-
ister for my upcoming classes. It’s my pleasure to em-
power you to attract your perfect customers online.

Magical Marketer Julia D. Stege, MFA helps people at-
tract their perfect customers with a unique combination 
of Law of Attraction, Wildly Attractive WebsitesTM, 

Branding from the HeartTM, and smart Social Network-
ing strategies. If you’re ready to start attracting your per-
fect customers now, get Julia’s free Magical Marketing 
Toolkit at http://www.magicalmarketingtoolkit.com

What is Social 
Networking?

http://www.whatissocialnetworking.com/

Social Networking - perhaps you’ve heard of it before, 
but are not quite sure what it means.  

Social networking is the grouping of individuals into 
specific groups, like small rural communities or a neigh-
borhood subdivision, if you will. Although social net-
working is possible in person, especially in universities, 
high schools or in the workplace, it is most popular on-
line. This is because unlike most high schools, colleges, 
or workplaces, the internet is filled with millions of in-
dividuals who are looking to meet other internet users, 
to gather first hand information or experiences about a 
medical condition, develop friendships, find vacation 
spots or to start a professional relationship.   Connecting 
Online

When it comes to online social networking, websites 
are commonly used. These websites are known as so-
cial sites. Social networking websites function like an 
online community of internet users. Depending on the 
website in question, many of these online community 
members share a common interest such as hobbies, re-
ligion, or politics. Once you are granted access to a so-
cial networking website you can begin to socialize. This 
socialization may include reading the profile pages of 
other members and possibly even contacting them. 

 The friends that you can make are just one of the many 
benefits to social networking online. Another one of 
those benefits includes diversity because the internet 
gives individuals from all around the world access to 
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social networking sites. This means that although you 
are in the United States, you could develop an online 
friendship with someone in Denmark. Not only will 
you make new friends, but you just might learn a thing 
or two about new cultures or new languages and learn-
ing is always a good thing.

Networking with FriendsAs mentioned, social net-
working often involves grouping specific individuals or 
organizations together. While there are a number of so-
cial networking websites that focus on particular inter-
ests, there are others that do not. The websites without 
a main focus are often referred to as “traditional” social 
networking websites and usually have open member-
ships. This means that anyone can become a member, 
no matter what their 
hobbies, be- liefs, or 
views are. However, 
once you are inside this 
online com- m u n i t y , 
you can be- gin to cre-
ate your own network of 
friends and el iminate 
m e m b e r s that do not 
share com- mon in-
terests or goals.

As I’m sure you’re aware, there are dangers associated 
with social networking: data theft and viruses are on 
the rise.  The most prevalent danger though often in-
volves online predators or individuals who claim to be 
someone that they are not.  Although danger does exist 
with networking online, it also exists with networking 
out in the real world, too. Just like you’re advised when 
meeting strangers at clubs and bars, school, or work -
- you are also advised to proceed with caution online. 
By being aware of your surroundings and who you are 
talking to, you should be able to safely enjoy social 
networking online. Just use common sense and listen 
to your inner voice; it will tell you when something 
doesn’t feel right.

Once you’ve convinced yourself that you are suffi-
ciently informed, you can begin to search for network-
ing communities to join. This can easily be done by 
performing a standard internet search. Your search will 
likely return a number of results, including MySpace, 

FriendWise, FriendFinder, Yahoo! 360, Facebook, 
Orkut, and Classmates.

Social Networking and Website 
Promotion
The Internet has evolved into a into a social envi-
ronment in addition to an information clearinghouse.   
Harness the viewership of the Internet with Social 
Networking and make it work for you.

Utilize social networking:   
  • As an online marketer;
  • To meet other like-minded people sharing the same 

interests; and
  • To find special friendships or perhaps something 

more.

Do you have a website that you would like to pro-
mote? Consider social networking as a platform to 
announce yourself and your internet business. If you 
incorporate social networking and internet participa-
tion into your online marketing efforts, you’ll begin 
to see your profits grow in response. Just how much 
depends upon the amount of time, effort
and hard work you’re willing to put into it.

If you are a member of an online forum and sign-off 
with your name or send e-mails (as most of us do), 
perhaps you are aware that you can create a signature 
line.  Often, you can choose a little smiley or some 
other icon or even upload your own photograph and 
attach it to a signature that you’ve created - much 
like the one we create in Outlook. Then, add your 
website name directly underneath your signature. 
Have more than one website?  Then go slow.  List 
only one website at each forum that you belong to. 
Some of the social networking sites like MySpace, 
don’t like blatant self-advertising, but you can dis-
creetly put in a small blurb with your signature.

Then join in the “talk” at forums or blogs and post 
your name at the end. Easier said than done  though 
because the hardest part of social networking is find-
ing the time to participate; especially if you have a 



full-time job.   If you just lurk around, reading the 
posts without participating, you won’t get the atten-
tion you need.  So, only join the groups and forums 
that you really need an association with.  Then, each 
time you post, you will create an association in the 
reader’s mind between your signature line, your web-
site and any product(s) or services that you offer.

You might also want to consider starting your own 
personal social site. They don’t necessarily originate 
with large companies or a few Fortune 500 folks.  So-
cial sites are quickly turning into niche social sites so 
it may be a good time for you to make the decision 
to move ahead in life.  Test the waters - who knows, 
starting your own social networking site might just 
be the big break ($$) you’ve been waiting for.  There 
are specific articles on the rest of this site relative 
to meeting people online. Just be careful, and watch 
your teenagers, too. These are trying times for every-
one. It’s not like the 60’s and 70’s. . .
or was that the 50’s?

Social Networking Sites: Should 
You Join?
Are you interested in meeting new people online?

Social networking websites allow internet users to 
communicate with each other and make connections 
- whether romantic, personal or professional.   De-
spite the fact that social networking website have 
rapidly increased in popularity and their popularity 
is expected to rise, there are many internet users who 
are unsure if actually joining is for them or, for that 
matter, whether they should allow their teens to join. 
Most teenagers want to fit in and find other friends 
to talk to so they’ll join MySpace or Facebook and 
Twitter. 

Think about why social sites are so popular. Doing so 
will enable you to determine why other internet users 
make the decision to join an online social network. 
After a close examination, you may even find that 
those are the same reasons why you want to join -to 
easily meet other internet uses.
Before the advent of social networking websites, it 
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was difficult to meet other internet users. Meet other 
internet users.If you tried, you would have to rely 
on chat rooms, instant messaging services and often 
communicate via email. As nice as these popular in-
ternet features are, they are not always considered 
safe. With chat rooms and the like, we’re often given 
little reassurance that a person is who they claim to 
be. We just took it on faith that people were being 
honest and forthright about themselves. Before the 
introduction of social networking sites’ “profiles” 
of its membership, there was no way that you could 
learn more about a particular internet user, even if 
you wanted to. But, social networking websites have 
changed that.

Not only have social networking websites made 
it safer to meet people online, it also allows us to 
meet people t h a t 
share the same o r 
similar interests. Most 
social network- i n g 
websites allow y o u 
to create your o w n 
profile; in fact, many 
even give you y o u r 
own webpage. These profiles or pages will allow you 
to share information about yourself, including your 
likes and dislikes, hobbies, education, etc. Since all 
other network members complete their own pages 
and profiles, it should be fairly easy for you to meet 
with other internet users, especially those who enjoy 
or believe in the same things that you do.

Another one of the many reasons why you should 
join a social networking website is because you lit-
erally have a wide variety of different choices.  As 
social networking websites have increased in popu-
larity, so did the number of websites that could be 
found online. Although Facebook is often deemed 
the most popular online social networking website, 
there are others that are just as easy or as much fun to 
use. Twitter has become a very popular site not only 
for keeping up with your friends, but for advertis-
ing as well.  You should easily be able to find those 
websites by performing a standard internet search for 
“social networking websites.”
Sharing common interestsIn your search, for social 
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networking websites, you will come across a number 
of different networks. Many of those sites will have 
a particular focus.  Unlike MySpace, which accepts 
just about any internet user, there are online social 
networks that aim to accept internet users that have 
a particular hobby, view, or belief. Online, it is not 
uncommon to find social networking websites that 
focus on politics, religion, pets, sports, medicine, 
pharmaceuticals, weight loss, depression, well, there 
are more than enough sites out there for you to find 
one you might be interested in joining.

If you are unsure about joining an online networking 
community, specialty networking sites may be your 
best bet. They are a great way to test the waters be-
cause they automatically pair you with internet users 
who have the same 
in te res t s , views, or be-
liefs as you do. There are 
even sites for dog and 
cat lovers: dogchannel.
com - as well as com-
m u n i t i e s for artists 
and art lov- ers: gazzag.
com.

Perhaps, the greatest reasons why should join a social 
networking website is because most are free to use. 
In addition to free social networks, there are online 
networks in which you are required to pay to join. Al-
though you may not want to pay for something that 
you can obtain for free elsewhere, you will find that 
most paid networks offer you more membership ben-
efits when compared to free social Meeting people 
online.networking sites.

Due to the fact that most social networking websites 
are free to use or at least, free to try, you are encour-
aged to give them a try.  If you are unsatisfied with 
your experience, you can easily cancel your member-
ship; often without any hassels. Then keep looking 
until you find a good fit.
The USO® is a community that’s been around for 
over 65 years. The USO offers many ways for U.S. 
citizens to get involved in a social networking kind-
of-way.

Social Networking Websites: 
How to Find Them
Each day, in the United States, millions of Americans 
communicate with each other online. 

In addition to communicating with other Americans, 
many are communicating with those on the other 
side of the world.  

When it comes to finding social networking websites, 
you have a number of different options.  You may 
want to search with the words “social networking” 
or “social networking websites.”  The focus of your 
search should be your main interest or topic.  If you 
are a veteran, look for military social networking; a 
christian, search for religious social networking sites; 
love animals, search for pet lovers social networking.  
Place the main word in front of the search phrase or 
at the end.  Either will return many results. 

Try words/phrases like:
-social networking sites for [a subject of interest]
-online community for [your hobbies]
-social networking communities for. . .

Should You Create Your Own So-
cial Networking Site?
Social networking is not just another fad. Social net-
works are here to stay. Facebook has 200,000,000 
registered users; Classmates has 50,000,000; and 
MySpace has 253,000,000 [Source:Wikipedia.com 
5-13-09].  While it’s true that some social sites will 
crash and burn on the information highway, others 
will spring up and blossom into smaller more spe-
cific communities.

These smaller social networking websites offer a 
more personalized experience by tightly focusing 
on the interests of its members rather than trying 
to build a brand. They are known as specialty net-
working sites or “niche” social networking sites, and 
people are willing to move from network to network 



until they find that one special site where they feel a 
genuine sense of connection and community.

More and more large companies, universities and 
small businesses are getting their own social web-
sites up and running so they can connect with their 
employees or students; fans or customers; and peo-
ple from all walks of life and socioeconomic back-
grounds. The types of social networking websites 
differ of course, due to the diverse nature of people, 
organizations and businesses. Naturally, then, there 
is a clear distinction between social networks that 
help you do something, like marketing your business 
or accomplish certain goals and those networks that 
offer a “social” connection. 

Are you thinking about developing your own so-
cial site? Creating a 
stand-alone community 
social site or adding 
community and social 
n e t w o r k - ing to a 
c o r p o r a t e website?  If 
the answer is yes, then 
you most likely will 
need profes- sional help.  
The con- siderations 
one must think about 
in creat- ing a social 
network site are endless 
and most of us aren’t even sure where to begin. Even 
though social site designs may look like normal web-
sites, a lot more is happening in the background than 
most people are aware of.

What do you want to accomplish with your social 
network? Will you develop and host your own ap-
plication, or hire someone? Are you aware of owner-
ship and intellectual property rights? What about the 
development process and functionality of the site? 
These questions and many, many more will need to 
be reviewed and answered by everyone involved in 
the project.
There’s layout and design, registration systems, cre-
ating custom signup for users, customizing fields for 
users to describe themselves, photos, videos, email 
messages, calendars, setting up user groups and so 
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forth. Additionally, there are important security mea-
sures that need to be addressed to prevent malicious 
attacks, unsolicited comments and profanity filters. 
Least we not forget, the site needs an administrator; 
someone with the technical knowledge and the time 
to monitor the site; to suspend or remove users who 
abuse their membership.

Online social networking is a phenomenon that has 
drastically changed the landscape of how people  
connect and socialize with each other. That social-
ization is possible through the internet and the social 
networking websites that are built by programmers 
and designers, individually or through a company. 
People interact and connect with each other from 
and “on” those websites. They provide a founda-
tion in which society reacts to new ideas through the 
viewpoints and opinions of others; sharing ideas and 
stories; find- ing inspira-
tion and in- formation 
relative to each par-
ticular users in te res t s , 
desires, and ambitions. 
Social net- w o r k i n g 
w e b s i t e s make it all 
happen and m i l l i o n s 
of people are happier 
because of them.

So, if you’re seriously thinking about starting a 
social networking site, talk with the professionals 
first; someone who has experience in web develop-
ment and programming. Whether it’s an individual 
or company, tell them what you have in mind, what 
service you want to provide, a niche product that you 
want to promote, or if you simply want your own 
personal networking website.   It could be fun and 
profitable, too!

Happy Social Networking!

✌



Sonoma Valley Computer Group Newsletter	 15	 http://www.vom.com/svcg/index.html

Protect Your 
Mac
By Matt Klein
Smalldog.com

We see a ton of 
damaged comput-
ers in the service 
department. It 
seems more com-
mon in our South 
Burlington tech 
room, as it’s right 
down the street 
from the

University of Ver-
mont and, well, it’s a college town. There are two pri-
mary types of physical damage: liquid spills and impact 
damage.

Liquid spills often mean the end of a machine’s useful 
life. If you spill anything in your computer, immediately 
turn it off by unplugging the MagSafe and removing the 
battery. Open it up and turn the machine upside down. 
Leave it alone. FOR A WEEK. If you bring your spill-
damaged machine in for service, we will not begin test-
ing for a week; this ensures that all the water has evapo-
rated.

If you drop your computer, it’s safe to try turning it on in 
most cases. Depending on the impact, the machine will 
probably have obvious denting and perhaps even a shat-
tered screen. I’ve seen quite a few dropped MacBooks 
come in with a dim screen, very little denting, and func-
tioning external video.

Dim screens can be caused by a failure of the LCD itself, 
the inverter board, various cables, main logic board, or 
a loose connection anywhere along the line. In the Mac-
Book that inspired this article, a very severe drop caused 
the connection from main logic board to inverter cable 
to come loose, resulting in a dim screen.

Of course, the best way to prevent impact damage is to 
keep your laptop in a well padded case.

Tip of the Week: 
Google Like a 
Pro	
By Matt Klein	
Smalldog.com

While there are 
plenty of viable 
search engines 
out there like 
Yahoo, Dogpile, 
and even Microsoft’s new Bing, we all know, love, 
and constantly use Google. There’s more to Google 
than simple search of the whole Internet. Here are a 
few ways to Google like a pro.

Exact phrase search is possible by wrapping your 
search terms in quotations marks. For example, 
“small dog electronics” vs. small dog electronics will 
bring up slightly different results, particularly if you 
use the Google News or Images service.

You can exclude words from a search by using a hy-
phen (-). Form your search for Lance Armstrong ar-
ticles that don’t talk about doping by typing “Lance 
Armstrong” -doping.

You can get the definition of a word by typing define:
obscure.

To show search results within a certain numeri-
cal range, you want to type your search terms fol-
lowed by the range. For example, Michael Jackson 
1970…1980.

For web sites with less-than-stellar search engines, 
why bother when you can use Google to search any 
page. For example, “small dog electronics” site:
timesargus.com will give news in the Barre/Montpe-
lier Times Argus newspaper.

If you read something fascinating and wonder who 
else links to the page you’re on, type link:twitter.
com/hellosmalldog
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Five Cool and 
Useful Tech-
niques for 
iMovie ‘09 and 
iDVD
Jeff Carlson
Sample Chapter is provided courtesy of Peachpit 
Press

It would be easy to overlook some video-editing and 
DVD-creation features in iMovie ‘09 and iDVD, as 
they aren’t immediately apparent to a new (or even 
longtime) user. But these tips from Jeff Carlson, au-
thor of iMovie ‘09 and iDVD for Mac OS X: Vi-
sual QuickStart Guide, are immediately useful - and 
loads of fun.

iMovie ‘09 is a huge update to Apple’s consumer 
video-editing software—one of those releases where 
the flagship new features, such as image stabiliza-
tion or the Precision Editor, really represent just the 
top crust of what’s been baked in. In the process of 
updating my book iMovie ‘09 and iDVD for Mac OS 
X: Visual QuickStart Guide, I found myself slicing-
and-dicing the new edition to make room for all of 
the new material.

The situation with iDVD is oddly the reverse; Apple 
pretty much left the DVD-creation program alone 
this time around (with one important exception, as 
I point out in this article). You can now export a 
movie directly from iMovie to iDVD, a feature that 
went absent in iMovie ‘08, but everything else is the 
same.

For that reason, and to keep the physical size (and 
price) of my book reasonable, I decided to pull out 
the iDVD section and offer it as a free download to 

Finally, you can do unit conversion right in Google. 
For example, 23 miles to km, 56 USD to Yen, 1 yard 
to meters.

I’m sure there is a ton of other stuff Google can do, 
but I’ll leave you with these Googling tips to find 
them for yourselves!

Beta No More	
By Kali Hilke	 
Smalldog.com

Gmail, Google Calendar, 
Google Docs and GTalk 
had their beta labels re-
moved.

Gmail, in particular, has been operating in beta mode 
for a considerable amount of time—it launched in 
2004—so it seems Google finally feels ready to re-
lease it officially into the wild…?

The beta label clearly doesn’t mean as much as it 
used to, since there was no big announcement to 
speak of when the apps switched over from their for-
mer mode. They all look and behave the same way 
they did yesterday, as far as I can tell.

However, there are changes, and they’re aimed spe-
cifically at businesses. Google wants their offerings 
to be viewed as legitimate competitors to Microsoft 
et al. It’s understandable that no matter how reliable 
a service may seem, the beta label would still keep 
many companies from utilizing it on a professional 
level. Again, Gmail is a good example.

Gmail now has offline access to mail and calendars, 
among other new features. There’s better contact 
management for Google Apps and better compatibil-
ity with Microsoft Outlook.

☺
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anyone who wants it. Click the Downloads tab on 
Peachpit’s book page, or just click here, to open the 
PDF of the iDVD section of the book. Then save 
your own free copy—more than 70 pages!

For this article, I’ve chosen five tips that are easy to 
overlook, but that can greatly improve your video-
editing and DVD-creation experience.

Tip 1: Add Any Location to a Travel Map

One of the flashy new features in iMovie ‘09 is the 
capability to create travel maps. Specify two loca-
tions, such as cities, and iMovie creates an animated 
map that draws a red line between the two. iMovie 
includes a database of 4,000 locations (cities, air-
ports, and many landmarks), which sounds like a lot 
but doesn’t cover the globe.

However, if you know the latitude and longitude of 
a location, iMovie can place it on one of its maps. 
Since you probably don’t have that information eas-
ily at hand (heck, I still get lost in my hometown), 
do this:

   1. Go to Get Lat Lon (http://www.getlatlon.com/), 
a website that looks up coordinates for you.
   2. Enter a place name, such as Elko NV, and click 
the Zoom to Place button. The specified place ap-
pears on the map, with the latitude and longitude 
coordinates listed below it (in this case, 40.83538, -
115.767178). Select those coordinates on the screen, 
and copy them by choosing Edit > Copy.
   3. In iMovie, add a map to your project (drag one 
from the Maps and Backgrounds browser to the Proj-
ect browser). iMovie’s inspector (a floating window) 
appears, with San Francisco as the Start Location.
   4. Click a location button to flip the inspector and 
reveal the Choose Location window.
   5. Paste the copied coordinates (Edit > Paste) into 
the field at the top. In the field at the bottom of the 
window, enter a name for the location (see Figure 1). 
You can change the name here for any location, even 

those that are in iMovie’s database.
    6. Click OK.

iMovie 09 and iDVD for Mac OS X: 
Visual QuickStart Guide

Figure 1 You can add a precise location to the maps 
in your movies.

7. To complete the journey, you can then specify an-
other location. To preview the effect, press the slash 
(/) key to play just that clip (see Figure 2).

Figure 2 Mark more than one location to create an 
animated line that connects the two locations.

Tip 2: Learn the Best Keyboard Shortcuts

When you use any program for an extended length 
of time, you’ll discover that keyboard shortcuts can 
dramatically improve the experience. Video editing 
takes time, so Apple’s engineers have incorporated 
several keyboard aids to make the process easier or 
to unlock hidden features that don’t warrant a but-
ton, menu item, or preference. Here are a few of my 
favorites, each of which you can do with one hand 
on the keyboard and one hand on the mouse as you 
edit.

    * iMovie’s Project browser displays your movie’s 
filmstrip in rows that wrap in the same way a para-
graph of text wraps in your word processor. When 
you get to the far-right edge of a row, the movie con-
tinues from the far-left edge of the next row down. 
When you skim (move your mouse pointer over the 
filmstrip), the Viewer displays the footage under the 
mouse pointer.
    * However, as you move the pointer past the right 
edge of a row, the preview in the Viewer stops. This 
behavior makes sense, because you should be free to 
move the mouse wherever you want, but it’s annoy-
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ignore the slider entirely. For example, if 50% is 
too fast but 25% is too slow, plug 46 into the field, 
as shown in Figure 3, and see whether that timing 
works better.

Figure 3 You have more control over iMovie ‘09 clip 
speed than you think you do.

Tip 4: Use Smart Titles, Maps, and 	
Photos

The iMovie designers engineered some smarts into a 
few areas of iMovie ‘09 that aren’t immediately ap-
parent. For example, the Four Corners title may seem 
broken at first. The two lines of text you specify fly 
into the lower-left corner of the screen from the left 
and bottom edges. The text then flies out toward the 
top and right edges. However, add the Four Corners 
title again, and the text arrives from the top and right 
edges, hangs out at the upper-right corner, and then 
exits via the left and bottom edges. Do that two more 
times, and you’ll have taken care of all four corners.

Another example is the Date/Time title. You can’t 
edit it, but that’s okay; it displays the clip’s actual 
date and time at the bottom of the screen, as shown in 
Figure 4. (It doesn’t advance like a real-time ticker, 
though.)

Figure 4 iMovie’s Date/Time title shows the clip’s 
actual date at the bottom of the screen.

Now let’s turn our attention to maps. You can set a 

ing if you’re trying to skim through your movie.
    * To continue previewing the footage, hold down 
the Shift key as you skim past the right edge, and 
iMovie jumps the playhead down to the next row. 
(View this trick in action on my website.) http://jeff-
carlson.typepad.com/imovievqs/2009/02/imovie-09-
tip-wraparound-cursor.html
    * Whenever the playhead crosses the filmstrip, you 
see a preview in the Viewer. On older machines, this 
behavior can slow performance. To disable the skim-
ming preview temporarily, hold down the Control 
key as you mouse over the area.
    * When you add a title to your movie by dragging 
one of the title styles from the Titles browser, iMovie 
highlights a portion of the clip to which you’re about 
to apply the title. Depending on where the playhead 
is, you can position the title at the beginning, end, 
or across the entire clip. For a bit more control, hold 
down the Shift key when dragging the clip. iMovie 
highlights a four-second area of the filmstrip, giving 
you more precision over where the title begins. As 
you drag, the Viewer displays the frame where the 
title will begin. This method also lets you straddle a 
title over multiple clips, instead of placing the title 
and then moving it into position later.

Tip 3: Change Clip Speed

iMovie ‘08, the complete rewrite of iMovie, lacked a 
feature that we’d grown accustomed to using in ear-
lier versions: Changing the speed of a clip. No slow-
motion replay of your kid’s winning goal, no sped-up 
footage of you assembling the entire Lego Millen-
nium Falcon.

Fortunately, the feature to change clip speed returned 
in iMovie ‘09. Double-click a clip to bring up the Clip 
Adjustments inspector and adjust the Speed slider.

But here’s a tip that’s hidden from view: You’re not 
limited to the amounts provided by the slider, which 
offers only a few preset tick marks. The slowest set-
ting using the slider is 12.5% of normal speed; the 
fastest is 800%. Those are both reasonable amounts, 
but iMovie can do better.

In the text field to the right of the Speed slider, enter 
any number between 5 and 2000 percent. You can 
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Start Location and an End Location for your inter-
active map. Assuming that you probably want to go 
back home at some point, iMovie automatically uses 
the previous map’s End Location as the Start Loca-
tion for the next map you make. This little conve-
nience is great when you’re putting together a jour-
ney with multiple destinations, making it easier to 
hop from New York to London to Madrid to Tokyo 
without having to reenter a lot of the same data.

Or look at the Ken Burns Effect that’s automatically 
applied to photos you add to your project. By default, 
the effect slowly zooms out. But when you add an-
other photo, the effect is reversed, and the camera 
zooms in on the picture. So, when you add 10 photos 
back to back, without doing anything else you end up 
with a nice series of pictures that smoothly zoom out, 
in, out, and so on.

Tip 5: Mark Chapters and Send to iDVD

Among its list of omissions, one longtime iMovie fea-
ture that didn’t make it into iMovie ‘08 was support 
for sending a project to iDVD. Turning your movie 
into a DVD involved a lengthy trip through Garage-
Band (or iMovie HD 6) before arriving at iDVD. 
iMovie ‘09 now includes this long-awaited feature, 
with a simpler way to create the markers for DVD 
chapters. The iDVD application barely changed at 
all; its version number has been incremented from 
7.0.2 to 7.0.4, and Apple removed the year from the 
title, so now it’s just iDVD.

But there’s a significant change that will catch long-
time iDVD users by surprise. Let’s take a look.

In iMovie, make sure that you have the program’s 
advanced tools enabled (choose iMovie > Preferenc-
es and click the Show Advanced Tools option in the 
General section of the window). After you close the 
window, two small buttons appear at the upper-right 
corner of the Project browser, as shown in Figure 5.

Figure 5 Turn on Show Advanced Tools in iMovie, 
and you’ll see a couple of extra small buttons in the 
Project browser.

Drag the icon on the right, identified with a white 
arrow, to a location in your project where you want 
a chapter to begin. Then type a name in the marker 
that appears, which is the chapter name that appears 
in iDVD (see Figure 6). That’s it. You can move the 
marker to a new location as needed, simply by drag-
ging it.

Figure 6 When you send your movie to iDVD, this 
marker location appears as a chapter in the DVD’s 
menu.

To send the project to iDVD, choose Share > iDVD. 
iMovie generates a full version of the movie, launch-
es iDVD, and creates a new project.

Now here’s the unusual part. When you preview the 
project in iDVD, the movie begins playing from the 
beginning automatically, before you even see the 
main menu. To make the DVD creation process as 
easy as possible for inexperienced users, Apple de-
cided to load a full version of the movie in iDVD’s 
Auto Play well. Click the Show the DVD Map button 
and look at the icon in the upper-left corner; that’s 
the Auto Play well (see Figure 7).

Figure 7 Any content in the iDVD Auto Play well 
begins playing as soon as the DVD is loaded.
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Anything put into that icon automatically plays as 
soon as a disc is loaded. Normally that’s a nice way 
to start the DVD, with a quick slideshow or intro-
duction, but in this case it’s the whole movie.

To prevent the movie playing first thing, simply drag 
the contents out of the Auto Play well. When you 
preview the project in iDVD or burn it to disc, the 
main menu will be the first thing to appear.

iTunes and You
By Christopher Breen
ht tp : / /www.peachpi t . com/ar t i c les /a r t i c le .
aspx?p=1278996

Sample Chapter is provided courtesy of Peachpit 
Press

To best understand what makes the iPod’s world 
turn, you must be familiar with how it and iTunes 
8 work together to move music (as well as pictures, 
videos, and games, in the case of some recent iPods) 
on and off your iPod. In the following pages, you’ll 
see just that.

A high-performance automobile is little more than 
an interesting amalgam of metal and plastic if it’s 
missing tires and fuel. Sure, given the proper slope 
(and, perhaps, a helpful tailwind), that car is capable 
of movement, but the resulting journey leaves much 
to be desired. So, too, the iPod is a less-capable mu-
sic-making vehicle without Apple’s multitrick media 
manager/player, iTunes. The two—like coffee and 
cream, dill and pickle, and Fred and Ginger—were 
simply meant for each other.

To best understand what makes the iPod’s world 
turn, you must be familiar with how it and iTunes 
8 work together to move music (as well as pictures, 
videos, and games, in the case of some recent iPods) 

on and off your iPod. In the following pages, you’ll 
see just that.
Getting the Goods

You have three ways to get tunes into iTunes:

    * Recording (or ripping, in today’s terminology) 
an audio CD
    * Importing music that doesn’t come directly from 
a CD (such as an audio track you downloaded or cre-
ated in an audio application on your computer)
    * Purchasing music from an online emporium such 
as Apple’s iTunes Store

The following sections tell you how to use the first 
two methods. The iTunes Store is a special-enough 
place that I devote all of Chapter 5 to it. The iTunes 
Wi-Fi Music Store gets its due in Chapter 6.
Rip a CD

Apple intended the process of converting audio-
CD music to computer data to be painless, and it is. 
Here’s how to go about it:

   1. Launch iTunes.
   2. Insert an audio CD into your computer’s CD or 
DVD drive.

      By default, iTunes tries to identify the CD you’ve 
inserted. It logs on to the Web to download the CD’s 
track information—a very handy feature for those 
who find typing such minutia to be tedious.

      The CD appears in iTunes’ Source list under the 
Devices heading, and the track info appears in the 
Song list to the right (Figure 4.1).

Figure 4.1 A selected CD and its tracks.

Then iTunes displays a dialog box, asking whether 
you’d like to import the tracks from the CD into your 
iTunes Library.

3.  Click Yes, and iTunes imports the songs; click No, 
and it doesn’t.
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NOTE
You can change this behavior in iTunes’ Preferences 
window. In the General tab you find a When You Insert 
a CD pop-up menu. Make a choice from that menu to 
direct iTunes to show the CD, begin playing it, ask to 
import it (the default), import it without asking, or im-
port and then eject it.

4.   If you decided earlier not to import the audio but 
want to do so now, simply select the CD in the Source 
list and click the Import CD button in the bottom-right 
section of the iTunes window (Figure 4.2).

Figure 4.2 iTunes’ Import CD button: Let ’er rip.

iTunes begins encoding the files via the method cho-
sen in the Import Settings area. (You reach this area 
by clicking the Import Settings button in the General 
preferences tab.) By default, iTunes imports songs in 
“high-quality” AAC format at 128 Kbps. (For more on 
encoding methods, see the sidebar “Import Business: 
File Formats and Bit Rates.”)

To import only certain songs, uncheck the 
boxes next to the titles of songs you don’t 
want to import; then click the Import CD 
button.

   5. Click the Music entry in the Source list.

      You’ll find the songs you just imported somewhere 
in the list.

   6. To listen to a song, click its name in the list and then 
click the Play icon or press the spacebar.

Import Business: File Formats and Bit 
Rates

MP3, MPEG-4, AAC, AIFF, WAV . . . is the computer 
industry incapable of speaking plain English?

It may seem so, given the plethora of acronyms float-
ing through modern-day Technotopia. But the lingo and 

the basics behind it aren’t terribly difficult to under-
stand.

MP3, AAC, AIFF, and WAV are audio file formats. 
The compression methods used to create MP3 and 
AAC files are termed lossy because their encoders 
remove information from the source sound file to 
create these smaller files. Fortunately, these encoders 
are designed to remove the information you’re least 
likely to miss—audio frequencies that humans can’t 
hear easily, for example.

AIFF and WAV files are uncompressed, which means 
that they contain all the data in the source audio file. 
When a Macintosh pulls audio from an audio CD, it 
does so in AIFF format, which is the native uncom-
pressed audio format used by Apple’s QuickTime 
technology. WAV is an AIFF variant used extensive-
ly with the Windows operating system.

iTunes supports one other compression format: Ap-
ple Lossless. This format is termed a lossless encoder 
because it shrinks files by removing redundant data 
without discarding any portion of the audio spec-
trum. This scheme yields sound files with all the 
audio quality of the source files at around half their 
size. iTunes and the iPod also support the H.264 and 
MPEG-4 video formats. These, too, are compressed 
formats that allow you to fit a great big movie on a 
tiny iPod.

Now that you’re familiar with these file formats, I’ll 
touch on resolution as it applies to audio and video 
files.

You probably know that the more pixels per inch a 
digital photograph has, the crisper the image (and the 
larger the file). Resolution applies to audio as well. 
But audio defines resolution by the number of kilo-
bits per second (Kbps) contained in an audio file. 
With files encoded similarly, the higher the kilobit 
rate, the better-sounding the file (and the larger the 
file).

I emphasize with files encoded similarly because the 
quality of the file depends a great deal on the encoder 
used to compress it. Many people claim that if you 
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encode a file at 128 Kbps in both the MP3 and AAC 
formats, the AAC file sounds better.

The Import Settings menu (which you reach via the 
General preferences tab) lets you choose to import 
files in AAC, AIFF, Apple Lossless, MP3, or WAV 
format. The Setting pop-up menu is where you choose 
the resolution of the AAC and MP3 files encoded by 
iTunes by choosing Custom from the menu. iTunes’ 
default setting is High Quality (128 Kbps). To change 
this setting, choose Higher Quality (256 Kbps) or 
Custom from the Setting pop-up menu. (Spoken 
Podcast is another option when you choose the AAC 
Encoder, but it produces quality that’s good only for 
spoken-word audio.) If you choose Custom, the AAC 
Encoder dialog box appears. Choose a different set-
ting—in a range from 16 Kbps to 320 Kbps—from 
the Stereo Bit Rate pop-up menu (Figure 4.3). Files 
encoded at a high bit rate sound better than those en-
coded at a low bit rate (such as 96 Kbps). But files 
encoded at higher bit rates also take up more space 
on your hard drive and iPod.
Figure 4.3 The Stereo Bit Rate pop-up menu.

The preset options for MP3 importing include Good 
Quality (128 Kbps), High Quality (160 Kbps), and 
Higher Quality (192 Kbps). If you don’t care to use 
one of these settings, choose Custom from this same 
pop-up menu. In the MP3 Encoder dialog box that 
appears, you have the option to choose a bit rate 
ranging from 16 Kbps to 320 Kbps.

Resolution is important for video as well. Fortunately 
(because an explanation beyond this gross simplifica-
tion is beyond the scope of this slim volume), iTunes 
allows you only to convert video to iPod/iPhone-
compatible format by choosing Advanced > Create 
iPod or iPhone Version. This command provides no 
tools for adjusting resolution settings.

Move music into iTunes
Ripping CDs isn’t the only way to put music files 
on your computer. Suppose that you’ve downloaded 
some audio files from the Web and want to put them 
in iTunes. You have three ways to do that:

    * In iTunes, choose File > Add to Library.

      When you choose this command, the Add To Li-
brary dialog box appears. Navigate to the file, folder, 
or volume you want to add to iTunes, and click Open 
(Figure 4.4). iTunes determines which files it thinks 
it can play and adds them to the library.

Figure 4.4 Navigate to tracks you want to add to 
iTunes via the Add To Library dialog box.

    * Drag files, folders, or entire volumes to the 
iTunes icon in Mac OS X’s Dock, the iTunes icon 
in Windows’ Start menu (if you’ve pinned iTunes 
to this menu), or the iTunes icon in either operating 
system (at which point iTunes launches and adds the 
dragged files to its library).

    * Drag files, folders, or entire volumes into iTunes’ 
main window or the Library entry in the Source list.

      In the Mac versions of iTunes, by default you’ll 
find songs in the iTunes Music folder within the 
iTunes folder inside the Music folder inside your 
Mac OS X user folder. The path to my iTunes mu-
sic files, for example, would be chris/Music/iTunes/
iTunes Music.

      Windows users will find their iTunes Music fold-
er by following this path: yourusername/My Music 
(XP) or Music (Vista)/iTunes/iTunes Music.

You can use the same methods to add compatible 
videos and movies to your iTunes Library. Those 
videos will most likely appear in the Movies playlist 



in the Source list.

I say most likely because there are a few exceptions: 
Videos specifically designated as music videos ap-
pear in the Music playlist, and videos designated as 
TV shows appear in the TV Shows playlist. See the 
sidebar “Tag, You’re It” at the end of this chapter for 
information on how to apply those video designa-
tions.

Creating and Configuring	
a Playlist
Before you put any media files (music or video) on 
your iPod, organize them in iTunes. Doing so will 
make it far easier to find the media you want, both 
on your computer and on your iPod. The best way to 
organize that material is through playlists.

A playlist is simply a set of tracks and/or videos that 
you believe should be grouped in a list. The organiz-
ing principle is completely up to you. You can or-
ganize songs by artist, by mood, by style, by song 
length . . . heck, if you like, you can have iTunes 
automatically gather all your 1950s polka tunes with 
the letter z in their titles. Similarly, you can organize 
your videos by criteria including director, actor, and 
TV-series title. You can mix videos and music tracks 
within playlists as well, combining, say, music videos 
and music tracks by the same artist. As far as playl-
ists are concerned, you’re the boss.

The following sections look at ways to create playl-
ists.

Standard playlists

Standard playlists are those that you make by hand, 
selecting each of the media files you want grouped. 
To create a standard playlist in iTunes, follow these 
steps:

   1. Click the large plus (+) icon in the bottom-left 
corner of the iTunes window, or choose File > New 
Playlist (Command-N on the Mac, Ctrl-N in Win-
dows).
   2. In the highlighted field that appears next to that 

new playlist in the Source list, type a name for your 
new playlist.
   3. Click an appropriate entry in the Source list—
Music, Movies, TV Shows, or Podcasts—and select 
the tracks or videos you want to place in the playlist 
you created.
    4. Drag the selected tracks or videos to the new 
playlist’s icon.
   5. Arrange the order of the tracks or videos in your 
new playlist.

To do this, click the number column in the main win-
dow, and drag tracks up and down in the list. When 
the iPod is synchronized with iTunes, this order is 
how the songs will appear in the playlist on your 
iPod.

If the songs in your playlist come from the same al-
bum, and you want the songs in the playlist to appear 
in the same order as they do on the original album, 
click the Album heading.

Playlist from selection

You can also create a new playlist from selected 
items by following these steps:

   1. Command-click (Mac) or Ctrl-click (Windows) 
songs or videos to select the files you’d like to appear 
in the new playlist.
   2. Choose File > New Playlist from Selection (Com-
mand-Shift-N on a Mac, Ctrl-Shift-N on a Windows 
PC).

A new playlist containing the selected items will ap-
pear under the Playlists heading in the iTunes Source 
list. If all selected tracks are from the same album, 
the list will bear the name of the artist and album. 
If the tracks are from different albums by the same 
artist, the playlist will be named after the artist. If 
you’ve mixed tracks from different artists or com-
bined music with videos, the new playlist will dis-
play the name untitled playlist.
     3. To name (or rename) the playlist, type in the 
highlighted field.
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Smart Playlists

Smart Playlists are slightly different beasts. They in-
clude tracks that meet certain conditions you’ve de-
fined—for example, Cowboy Junkies tracks encoded 
in AAC format that are shorter than 4 minutes. Here’s 
how to work the magic of Smart Playlists:

     1. In iTunes, choose File > New Smart Playlist 
(Command-Option-N on the Mac, Ctrl-Alt-N in 
Windows).

      You can also hold down the Option key on the 
Mac or the Shift key on a Windows PC and then click 
the gear icon that replaces the plus icon at the bottom 
of the iTunes window.
   2. Choose your criteria.

You’ll spy a pop-up menu that allows you to select 
items by various criteria—including artist, composer, 
genre, podcast, bit rate, comment, date added, and 
last played—followed by a Contains field. To choose 
all songs by Elvis Presley and Elvis Costello, for ex-
ample, you’d choose Artist from the pop-up menu and 
then enter Elvis in the Contains field (Figure 4.5).

Figure 4.5 The inner workings of a smart playlist.

You can limit the selections that appear in the playlist 
by minutes, hours, megabytes, gigabytes, or number 
of songs. You may want the playlist to contain no 
more than 2 GB worth of songs and videos, for ex-
ample.

You’ll also see a Live Updating option. When it’s 
switched on, this option ensures that if you add any 
songs or videos to iTunes that meet the criteria you’ve 
set, those files will be added to the playlist. If you add 
a new Elvis Costello album to iTunes, for example, 
iTunes updates your Elvis Smart Playlist automati-
cally.

   3. Click OK.

A new playlist that contains your smart selections ap-
pears in iTunes’ Source list.

You don’t have to settle for a single criterion. By 
clicking the plus icon next to a criterion field, you 
can add other conditions. You could create a playlist 
containing, say, only songs you’ve never listened to 
by punk artists whose names contain the letter J.

Folders for playlists

You can also file playlists in folders. By invoking the 
File > New Playlist Folder command, you can lump 
a bunch of playlists into a single folder. Folders are a 
great way to keep your playlists separate from your 
spouse’s or to gather groups of similar playlists (All 
My Jazz Playlists, for example).

At one time, folders didn’t translate to the iPod; how-
ever, the 3G and 4G iPod nanos and the iPod classics 
do offer nested playlist hierarchies. The iPod touch 
doesn’t. Instead, when you move a folder full of play-
lists into the iPod touch, all those playlists appear as 
separate entries in the touch’s Playlists screen.

Genius playlists

If you’re the kind of reader who starts at the begin-
ning of a book and plows through to the end, you’re 
aware, from the previous chapter, of the Genius fea-
ture on the iPod. iTunes 8 and later can also create 
Genius playlists—playlists of music that iTunes be-
lieves to be related to other music in your library. 
You get those playlists this way:

   1. Switch on the Genius feature.

When you install iTunes, you’re offered the choice to 
turn Genius on. Doing so requires an iTunes account. 
If you don’t have one, no worries. When you start the 
Genius process you’ll find an option for signing up 
for an account. If you neglected to turn on Genius, 
you can do so by choosing Store > Turn on Genius. If 
you’re connected to the Internet, iTunes will ask you 
to sign into your iTunes account.
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   2. Wait while iTunes configures Genius.

iTunes gathers information about your music li-
brary—specifically, the songs it contains—and sends 
that information to Apple’s severs anonymously. 
That information is compared with similar data from 
other users and placed in a database. A database file 
that contains the relationship data is sent back to your 
computer.

   3. Create a Genius playlist.

Select a track in your iTunes Library, and click the 
Genius button in the bottom-right corner of the iTunes 
window. iTunes will create a new playlist of 25 songs 
(by default) that should go well with the track you se-
lected. You can ask Genius to create a longer version 
of this playlist by making a larger choice from the 
Limit To pop-up menu at the bottom of the window; 
your choices are 25, 50, 75, and 100 songs. You can 
also click Refresh to ask Genius to try again.

   4. Save the playlist.

When you click the Save Playlist button at the top 
of the window, iTunes creates a playlist named af-
ter your source track—A Common Disaster, for ex-
ample. You can return to any Genius playlist you’ve 
created and change the Limit To settings as well as 
refresh the playlist.

   5. Expose the Genius sidebar.

Click the Sidebar icon in the bottom-right corner of 
the iTunes window to display the Genius sidebar, 
which is designed to recommend related music from 
the iTunes Store (Figure 4.6).

Figure 4.6 The Genius sidebar.

At the tip of the sidebar, you’ll find entries that in-
clude top albums by the currently playing artist, top 

songs you’re missing, iTunes Essentials collections 
that include the artist, and a list of tracks by related 
artists. Next to the Top Songs You’re Missing and 
Recommendations selections you’ll see both a Pre-
view button (denoted by an eighth note) and a Buy 
button. To audition 30 seconds of a track, just click 
the Preview button. If you like what you’ve heard 
and would like to own the track, click Buy. In the re-
sulting dialog box you’ll be prompted for your Apple 
ID and password. Enter that info and click the Buy 
button, and the track downloads to your computer.

NOTE

You can sync Genius playlists to your iPod just as 
you can any other playlists.

Key iTunes Features
Intuitive though it may be, iTunes packs a lot of fea-
tures and power—enough that I could write an entire 
book about just this application. We have bigger fish 
to fry: getting the most out of your iPod. But part 
of frying those fish is learning about the key iTunes 
features that can make using and listening to your 
iPod more enjoyable. In this section, I examine those 
features.

iTunes preferences

Choose iTunes > Preferences on a Mac or Edit > 
Preferences on a Windows PC, and you open iTunes’ 
Preferences window. Some of the tabs within this 
window hold settings you should know about.

General

I’ve already mentioned that within the General tab, 
you specify what happens when you insert a CD. Else-
where in this tab you’ll see options for showing or 
hiding certain items in iTunes’ Source list, including 
Movies, TV Shows, Podcasts, Audiobooks, Genius, 
Applications, Radio, Party Shuffle, and Ringtones. If 
you find iTunes’ interface too cluttered, disabling the 
items you don’t use will clean things up.
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Playback

Here, you can determine where in the iTunes inter-
face movies, TV shows, and music videos are dis-
played (in a separate window, for example) and the 
default language and subtitle language for movies. 
But the most interesting settings here are Crossfade 
Songs, Sound Enhancer, and Sound Check.

Crossfade Songs. This setting causes the end of each 
song to fade out and the beginning of the next track 
to fade in. For some people, this feature makes for 
a less jarring listening experience. You can set the 
length of the crossfade—from 1 to 12 seconds—with 
a slider. These settings don’t transfer to the iPod.

Sound Enhancer. This feature is a kind of audio filter 
that can expand and brighten the sound coming from 
iTunes tracks. It’s worth playing with to see whether 
its results please you. These settings don’t transfer to 
the iPod either.

Sound Check. In Chapter 2, I talk about the Sound 
Check feature on the iPod and how you have to en-
able it. This tab is where you do that. The feature’s 
job is to try to make volumes across all the songs in 
your library similar.
Sharing

iTunes allows you to easily share your music library 
or just specific playlists in it with other copies of 
iTunes running on a local network (and allows those 
iTunes libraries to be shared with you). You can share 
your library by enabling the Share My Library on 
My Local Network option. To seek out other iTunes 
shared libraries, enable the Look for Shared Libraries 
option.

Parental

Not all music and video is appropriate for all ages. 
Using the Parental tab, you can disable podcasts, ra-
dio, the iTunes Store, and shared libraries, as well as 
restrict content from the iTunes Store.

Advanced

The Advanced tab is where you tell iTunes the loca-
tion of your media files and how to organize them. In 
Chapter 9, I put this tab to good use to shift an iTunes 
Library from a cramped startup drive to a more ex-
pansive external drive.

Info window

I talk about tagging a fair amount in this chapter. By 
tagging, I don’t mean playing the kids’ game, but 
practicing the subtle art of marking files with identi-
fying bits of information (such as title, artist, album, 
and genre) so that you can locate and organize them 
more easily. You do all this in an item’s Info win-
dow.

To produce an Info window, just select any hunk 
of media in your iTunes Library—such as a song, 
video, or podcast—and choose File > Get Info. The 
resulting window contains several tabs. For purposes 
of this chapter, the important ones include the fol-
lowing.

Info

This tab is where all the tagging business takes 
place. Here, you find fields for such information as 
name, artist, album, composer, comments, year, and 
track number, as well as a Genre menu (Figure 4.7). 
iTunes is pretty good about filling in this informa-
tion for you, but at times you may need to tag your 
own music—when a ripped CD isn’t recognized, for 
example, or when you’ve ripped someone else’s mix 
CD and iTunes can’t identify its tracks.

Figure 4.7 The Info tab.

Video

When you import TV episodes from sources other 
than the iTunes Store, that video may lack the proper 
tags—show name, season. and episode number, for 
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ist, album, composer, comments, genre, artwork, and 
rating. This feature is handy for adding one piece of 
album artwork to a group of tracks.

EQ and the iPod

Having EQ built into iTunes and the iPod is great, 
but the interaction between iTunes and the iPod in 
regard to EQ is a little confusing. Allow me to end 
that confusion.

In iTunes, you can assign an EQ setting to a song in-
dividually by clicking the song, pressing Command-I 
(Mac) or Ctrl-I (Windows), clicking the Options tab, 
and then choosing an EQ setting from the Equalizer 
Preset menu. When you move songs to your iPod, 
these EQ settings move right along with them, but 
you won’t be able to use them unless you configure 
the iPod correctly.

If, for example, you have EQ switched off on the iPod, 
songs that have assigned EQ presets won’t play with 
those settings. Instead, your songs will play without 
the benefit of EQ. If you set the iPod’s EQ to Flat, 
the EQ setting that you preset in iTunes will play on 
the iPod. If you select one of the other EQ settings 
on the iPod (Latin or Electronic, for example), songs 
without EQ presets assigned in iTunes will use the 
iPod EQ setting. Songs with EQ settings assigned in 
iTunes will use the iTunes setting.

If you’d like to hear how a particular song sounds on 
your iPod with a different EQ setting, start playing the 
song on the iPod, tap the Home button, tap Settings 
> iPod > EQ, and then select one of the EQ settings. 
The song will immediately take on the EQ setting 
you’ve chosen, but this setting won’t stick on subse-
quent playback. If you want to change the song’s EQ 
more permanently, you must do so in iTunes.

Move Music and Video to the 
iPod (shuffle Excluded)
NOTE

The next few pages don’t apply to the iPod shuffle, 
as its iTunes interface is significantly different from 
the one used for other iPod models. Because it is so 

example. The Video tab contains fields for exactly 
that information.

Options
Within the Options tab you can adjust a track’s vol-
ume so that it’s louder or softer, choose an equal-
izer (EQ) preset (see the nearby sidebar “EQ and the 
iPod”), and select an item’s media type. For videos, 
the media type will be movie, TV show, or music 
video; for audio files, it will be music or audiobook.

You can also impose start and stop times on a track. 
This feature is useful when you can’t stand the first 
minute of a song or podcast and want to skip over it 
automatically whenever you play it. Do that by en-
abling the Start Time option and then entering 1:00 
in the text box.

Finally, cock a keen eye at the Rating field. Here, 
you can rate your tracks from one to five stars. (You 
can also rate tracks by clicking the Rating column 
next to a track’s name, as well as selecting a track 
and choosing a rating from the Rating submenu of 
the File menu.) Rating your media now is helpful for 
creating Smart Playlists later, basing those playlists 
on songs and videos you enjoy.

Lyrics

You recall that your iPod can display lyrics, right? 
This tab is where you enter them.

Artwork

iTunes is more than happy to seek out album artwork 
for you, but it locates artwork only for albums that 
are available from the iTunes Store. If you import 
an album that can’t be had from the Store, a generic 
icon appears in Grid and Cover Flow views. You can 
add your own artwork simply by dragging a graphic 
file into the artwork field in the Artwork tab.

 You can tag multiple files simply by se-
lecting more than one file and choosing File > Get 
Info. A Multiple Item Information window appears, 
and you can add tags therein for such things as art-
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different, I’ve chosen to devote the latter portion of 
this chapter to the shuffle.

Now that your media is organized, it’s time to put it on 
your ’pod. The conduit for moving music, podcasts, 
audiobooks, videos, and (for some iPods) applications 
and games to the iPod is iTunes—which, fortunately, 
can be fairly flexible in the way it goes about the pro-
cess.

You have several ways to configure iTunes so that 
your iPod is updated when you want it to be. It’s just 
as possible to configure iTunes so that only the music 
and videos you want are copied to your iPod. The key 
is the iPod Preferences window.

To start, plug your iPod into your computer, and 
launch iTunes. (By default, iTunes launches when you 
connect the iPod.) The iPod appears under the Devices 
heading in iTunes’ Source list (Figure 4.8). To open 
the iPod Preferences window, select the iPod in the 
Source list.

 
Figure 4.8 iPods in iTunes’ Source list.

Within the iPod Preferences window, you’ll find 
eight panes if you have a 5G iPod, 3G or 4G iPod 
nano, or any iPod classic: Summary, Music, Movies, 
TV Shows, Podcasts, Photos, Contacts, and Games. 
Those with an iPod touch will find Summary, Music, 
Movies, TV Shows, Podcasts, Photos, Info, and Ap-
plications. If you have a color iPod that doesn’t offer 
video (including 1G and 2G iPod nanos), the Movies, 
TV Shows, and Games tabs will be absent. For mono-
chrome iPods, the Photos tab will also be missing.

Below these tabs, you’ll see the Capacity bar (Figure 
4.9), a thermometerlike display that details how much 
media is on your iPod. With any of today’s display-
bearing iPods plugged into your computer, you’ll see 
entries for Audio, Video, Photos, Other (data such as 
files you’ve copied to the iPod, notes, contacts, and 
calendars), and Free.

Figure 4.9 The iPod touch’s Capacity bar.

The iPod touch adds an Apps entry. Click the bar, 
and the display cycles through the amounts of stor-
age used by each kind of media (measured in GB 
and MB), the numbers of items of each kind of me-
dia (7,660 songs, 109 videos, and 6,098 photos, for 
example), and how long it would take to play all the 
audio and video files (26.6 days, for example).
Here’s how the panes shake out.

Summary

In iTunes 7 and later, the Summary pane provides 
such details about your iPod as its name, capacity, 
software version number, serial number, and format 
(Macintosh or Windows). It also tells you the version 
of the iPod software it’s running and offers you the 
option to update that software if newer software is 
available or to restore your iPod (essentially, erase its 
contents and give it a new operating system). I cover 
the ins and outs of restoring your iPod in Chapter 9.

Finally, the Summary tab offers these options.

Open iTunes When This iPod Is Connected

Most likely, you’re going to want to sync or oth-
erwise muck with your iPod when you plug it into 
your computer. This option saves you the trouble of 
launching iTunes manually.

Sync Only Checked Songs and Videos

This option provides fine control over which files 
you sync to the iPod. Checking the box for this op-
tion lets you prevent files from loading onto the iPod 
by unchecking the small check boxes next to their 
names in playlists and Library lists.

 Care to check or uncheck all the songs in 
a playlist at the same time? On the Mac, hold down 
the Command key and click any check box in the 
playlist. In Windows, hold down the Control key and 
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do the same thing. When you uncheck a box, all boxes 
will be unchecked; check a box, and all boxes will be 
checked.

Manually Manage Music and Videos

This small option offers a lot of power. To understand 
its usefulness, it’s helpful to know that by default, when 
you sync iTunes and the iPod, iTunes moves only the 
files you ask it for onto the iPod and erases everything 
else from the device. This arrangement can be a real 
bother if you’ve moved your iPod from one computer 
to another and the contents of the second computer 
don’t match those of the first.

Managing files manually allows you to add music (and 
videos, for compatible iPods) to your iPod without 
erasing any other media. When you select this option, 
all the playlists on your iPod appear below the iPod’s 
icon in the iTunes Source list. (For the sake of simplic-
ity, I’ll say that the Music, Movies, TV Shows, Pod-
casts, and Audiobooks entries count as playlists.)

NOTE

As I hint, you can use this technique to copy music to 
your iPod from multiple computers, but it doesn’t work 
with the iPod touch. Although you can manually man-
age music and video to the touch to the point where 
you can drag media to it in iTunes’ Source list, if you 
attempt to sync the touch to another computer, you’ll 
be told that you must erase all the music and video on 
it when you sync it with the new computer.

To add media files to the iPod manually, just select 
them in one of iTunes’ playlists, and drag them to the 
iPod’s icon in the Source list or to one of the iPod’s 
standard (not Smart) playlists (Figure 4.10). You can 
also drag files from your computer’s desktop directly 
to the iPod, which copies the media to the iPod but not 
to your iTunes Library.

 Figure 4.10 Manually dragging 
files to an iPod.

Optionally, you can add songs by genre, artist, or al-

bum by using iTunes’ browser. To do so, follow these 
steps:

   1. In iTunes, choose View > Show Browser (Com-
mand-B in Mac OS X, Ctrl-B in Windows).

      A pane divided into Genre, Artist, and Album col-
umns appears at the top of iTunes’ main window.
   2. Click an entry in one of the columns.

      If you want to copy all the Kate Bush songs in 
your iTunes Library to the iPod, for example, click 
Ms. Bush’s name in the Artist column. To copy all 
the reggae tunes to the iPod, select Reggae in the 
Genre column.

   3. Drag the selected item to the iPod’s icon in the 
Source list or to a playlist you’ve created on the 
iPod.

To remove songs from the iPod, select the songs you 
want to remove within the iPod entry in the Source 
list; then press your keyboard’s Delete key (or Con-
trol-click on the Mac or right-click for Windows, and 
choose Clear from the contextual menu). Mac users 
can also drag the songs to the Trash.

NOTE

When you remove songs from your iPod, you don’t 
remove them from your computer. Unless you select 
a song in iTunes’ Library and delete it, the song is 
still on your hard drive.

You can even copy entire playlists to other playlists 
by dragging one playlist icon on top of another. This 
method works for both iTunes and iPod playlists, 
though you can’t drag a playlist on the iPod to an 
iTunes playlist and expect the songs to copy over. 
Under most circumstances, tracks on the iPod don’t 
copy to your computer (unless you know the tricks 
detailed in Chapter 9).

But wait—there’s more. iTunes 8 includes two addi-
tional views: Grid and Cover Flow. Click the second 
button in the View palette at the top of the window to 
see Grid view; Cover Flow view appears when you 
click the third button. When you click the Grid button, 
you can view your music in Albums, Artists, Genres, 
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or Composers view. These views work this way.

Albums. Each album cover in the selected entry (music 
or a playlist) is displayed (Figure 4.11). Mouse over the 
cover, and a Play Album entry appears. Click the Play 
symbol in this icon, and the album begins playing from 
the first track. Double-click an album cover, and a page 
opens that displays the album cover and the tracks on the 
album. To return to the previous Grid view, click the All 
Albums entry in the top-left corner of the window.

 
Figure 4.11 Albums in Grid view.

NOTE

If iTunes can’t find the album artwork for a particular 
album, the cover shows a generic icon of two eighth 
notes.

Artists. When you click Artists you’ll still see album 
covers, but those covers will be grouped by artist. If you 
have tracks from more than one track by an artist, select 
an artist and roll your mouse horizontally over the cover; 
the album covers will change to reflect all the artist’s al-
bum entries. A Play All Artist entry also appears. Click 
the Play symbol in it, and iTunes begins playing the first 
track from the first album title, sorted alphabetically. 
Click All Artists to return to Grid view.

Genres. Seeking a quick way to find all the World mu-
sic in your iTunes Library? Click the Genres entry, and 
you’ll see the selected playlist’s music categorized by 
genre. (Those songs must have their Genre tag filled in 
to appear in this view, however. See the sidebar “Tag 
You’re It” at the end of this chapter for more information 
on tags.) For common genres, you’ll see custom icons 
provided by Apple—Rock, Soundtrack, and World, for 
example. If tracks have a less-common genre type as-
signed to them—Ska, Metal, or Fusion, for example—
you’ll see the album cover for a track tagged with that 
genre or iTunes’ generic eighth-notes icon.

As in Artists and Albums views, select an icon and move 

your mouse over it horizontally, and album covers ap-
pear. Click the Play symbol within the Play Genre entry 
that appears over selected icons to play all the music 
within that genre. Music is organized alphabetically by 
the artist’s first name.

Composers. You know the drill by now. Tracks are 
organized by composers when those tracks contain a 
Composer tag. If not, you’ll find the remaining tracks 
files listed under Unknown Composer. Click the Play 
symbol in the Play Composer entry to play. Tracks are 
organized first by artist and then by album title. If you 
choose the leader of The Who, Pete Townshend, for ex-
ample, his solo albums come first in alphabetical order; 
then come The Who’s albums in alphabetical order.

Cover Flow view is kind of a lazy-Susan affair that rep-
resents your library as a series of covers (Figure 4.12). 
You can move music from these views to your iPod 
simply by dragging the cover art from the view to the 
iPod’s icon. The contents of that album, video, or pod-
cast will be transferred to the iPod.

Figure 4.12 Cover Flow view.

The Perfect Dismount

When you choose to manage your songs and playlists 
manually, you’ll be told that you have to disconnect 
all display-bearing iPods except the iPod touch manu-
ally—meaning that you have to take action to unmount 
the thing, rather than simply unplug it from your com-
puter.

To do so, you can click the Eject icon next to the iP-
od’s name in the Source list, or select the iPod and then 
click the small iPod icon that appears in the bottom-
right corner of the iTunes window. Alternatively, Mac 
users can switch to the Finder and drag the iPod to the 
Trash; when its icon disappears from the Desktop, you 
can unplug your iPod. Windows users can invoke the 
Safely Remove Hardware command from the notifica-
tion area.

If you unmount the iPod by doing something rash like 
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unplugging it, your computer’s operating system will 
complain, and your iPod may not have all the media 
you wanted it to have if it was busy doing something at 
the time.

Enable Disk Use (all iPods except iPod touch)

The iPod is, at heart, an elegant storage device that hap-
pens to play music (and in some cases, slideshows and 
videos too). You can mount all iPods except the iPod 
touch as a hard drive on your computer by enabling this 
option. When the iPod is mounted, you can use it just 
like a hard drive; copy files to it as you desire.

Music

The Music pane (Figure 4.13) contains options for sync-
ing music and music videos to your iPod, as well as for 
displaying album artwork on all color iPods save for the 
iPod touch. (The iPod touch always syncs album art-
work, so you won’t find this option in the Music pane 
when you connect a touch.)

Figure 4.13 The Music pane.

Enabling the Sync Music option tells iTunes that you’d 
like it to sync its music collection to the iPod automati-
cally. If you’ve enabled the Manually Manage Music 
and Videos option in the Summary pane, enabling the 
Sync Music option overrides the Manual option (iTunes 
will ask you if you’re sure you want to do this). When 
you’ve chosen Sync Music, you then have the choice to 
sync all songs and playlists or just selected playlists.

Any songs currently on the iPod that aren’t in the iTunes 
Library or in the selected playlists are erased from the 
iPod.

Why choose selected playlists rather than your entire 
music library? For one thing, your iPod may not have 
the capacity to hold your entire music collection. This 
option is also a good one to use when several members 
of your family share an iPod. It allows you to chunk up a 

music collection into multiple playlists and then rotate 
those playlists in and out of the iPod.

If you’ve removed songs from the iTunes Library and 
want them to remain on your iPod after the update, 
you’ll want to avoid this option and manage your music 
manually.

You’ll also see an option at the bottom of the window to 
sync music videos. Enable it, and any music videos in 
selected playlists will also be synced to your iPod. Turn 
the option off, and music videos will steer clear, even if 
they’re part of a playlist.

Movies

The Movies pane is similar to the Music pane. Here, 
you’ll find the option to Sync Movies and then choices 
to sync All Movies; All Unwatched Movies; 1, 3, 5, or 
10 Most Recent Unwatched Movies; Selected Movies; 
or Selected Playlists. iTunes provides this greater level 
of sync control because movies take up a lot of space, 
and a large movie collection and even the highest-ca-
pacity iPod may not mix.

Again, if you enable the Sync Movies option, you undo 
the Manually Manage Movies and Videos setting if 
you’ve switched it on.

TV Shows

In the TV Shows tab, you see a list of all the videos 
marked as TV Shows in your iTunes Library (Figure 
4.14). You can sync all or the 1, 3, 5, or 10 most recent 
TV shows among all TV shows, or just selected shows 
or playlists from the list of shows below. Or you can 
sync all unwatched episodes; the 1, 3, 5, or 10 most 
recent or least recent unwatched episodes of all TV 
shows; or selected TV shows or playlists.

Figure 4.14 The TV Shows pane.



 What’s with this “least recent unwatched 
episodes” stuff? If you’ve downloaded a season of a TV 
series, you’d choose this option so that the shows sync 
in order from the beginning of the season to the end. If, 
instead, you chose the most recent unwatched episodes, 
playback would start with the last show and then work 
its way backward. (If that wouldn’t spoil the suspense, I 
don’t know what would!)

Podcasts

What puts the pod in podcast is the iPod. Because people 
tend to listen to lots of podcasts, some of which tend to be 
long (their files therefore taking up significant amounts 
of room), iTunes lets you manage which ones are synced 
to your iPod.

As in each one of these tabs, you have the option to not 
sync this content. But if you choose to, you have plenty 
of options. You can choose all podcasts, all unplayed 
podcasts, or all new podcasts. Or you have the option to 
play 1, 3, 5, or 10 of the following: the most recent pod-
casts, the most recent unplayed podcasts, the least recent 
unplayed podcasts, the most recent new podcasts, or the 
least recent new podcasts. These settings apply to either 
all your podcasts or just those you’ve selected.

Note that video as well as audio podcasts are included 
here. Because video can consume a lot of storage space, 
be careful how you choose your video podcasts.

Photos (color iPods only)

If you use a Mac, an iPod with a color display can sync 
photos with Apple’s iPhoto and Aperture, as well as with 
your Photos folder or a different folder of your choos-
ing. On that Mac, you also have the option to sync just 
specific iPhoto events. On a Windows PC, you can sync 
with your My Pictures folder, a different folder of your 
choosing, or photo albums created with Adobe Photo-
shop Elements 3 or later or Adobe Photoshop Album 2 
or later. To do this, enable the Sync Photos From option, 
and, from the pop-up menu that follows it, choose the 
source for your photos.

When you choose iPhoto or Aperture, the option below 

the pop-up menu reads All Photos and Albums, and even-
tually tells you how many photos are involved (9,548 
photos, for example). When you enable this option and 
sync the iPod, all the pictures in your iPhoto or Aperture 
library will be converted and copied to the iPod. You also 
have the Selected Albums option, which works much like 
the Selected Playlists option in the Music pane (Figure 
4.15). Regardless of which option you choose, whenever 
you add new images to a selected album, the iPod auto-
matically updates its photo library when it next synchro-
nizes.

Figure 4.15 The Photos pane.

You can also select Choose Folder from the Sync Pho-
tos From pop-up menu. When you do, up pops a Change 
Photos Folder Location navigation window. Just traipse 
to the folder you want to pull pictures from, and click 
Open. When you do this, the folder you’ve chosen ap-
pears in the pop-up menu.

If you choose Pictures from this pop-up menu, the options 
below it change to All Photos and Albums and Selected 
Folders. The principles of iPhoto/Aperture import apply 
here as well. If you choose All Photos, iTunes rummages 
around in this folder and looks for compatible graph-
ics files. If you choose Selected Folders, you can direct 
iTunes to look in only those folders that you select.

 This method is a good way to copy every pic-
ture from your hard drive to your iPod. As far as iTunes 
is concerned, your hard drive is just another folder. Select 
it as the source folder with the All Photos option selected, 
and iTunes grabs all the compatible graphics files it can 
find, converts them, and plunks them onto your iPod.

This process is no more complicated for Windows us-
ers. The main difference is that the Windows version of 
iTunes offers no iPhoto option (and because no version 
of iPhoto is available for Windows, that’s probably a 
good thing). Instead, you’ll see the option to sync All or 
Selected Folders from your My Pictures folder or another 
folder of your choosing.
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If you’ve installed Adobe Photoshop Elements (version 
3 or later) or Adobe Photoshop Album on your PC, the 
Sync Photos From pop-up menu also contains entries for 
these programs, allowing you to import pictures from the 
albums that these programs create.

 The tip I propose for copying all the pictures 
from your Mac to your iPod works in Windows as well. 
In this case, choose your C drive as the source. When you 
do, every compatible graphics file will be converted and 
copied.

At the bottom of the Photos window you’ll see an Include 
Full-Resolution Photos option when you’ve plugged 
in any color iPod except the iPod touch. It says what it 
means. When you enable it, iTunes creates a Photos folder 
at the root level of the iPod, and it hurls into that fold-
er full-resolution versions of your photos rather than the 
slimmed-down photos that the iPhoto displays. This op-
tion is primarily for transporting your photos; the iPod 
can’t display them.

To access them, enable disk use on the iPod, locate the 
iPod on your computer’s desktop, open the Photos folder, 
and then open the Full Resolution folder within. This fold-
er is organized in a logical way. When you open the Full 
Resolution folder, you’ll see a folder that bears the year 
the pictures were created. Within this folder are folders 
marked with the month of creation. Within one of these 
folders is a folder denoting the day of conception. So the 
folder hierarchy might look like this: Photos/Full Resolu-
tion/2008/2/28/yourphotos.

Contacts (all display-bearing iPods except iPod touch)

iTunes handles synchronization of contacts and calendars 
between your computer and iPod. The Contacts pane of-
fers synchronization options for your computer’s main 
contacts and calendars applications. From the Contacts 
pane on a Macintosh, you can choose to synchronize all 
your Apple Address Book contacts or just those contacts 
from selected groups. On a Windows PC, iTunes synchro-
nizes Windows’ Address Book (called Windows Contacts 
in Vista) or Microsoft Outlook contacts in the same way—
either all contacts or selected groups of contacts. Only in 
the Macintosh version of iTunes do you also have the op-

tion to include the photo associated with your contact.

Below the Contacts section of the pane, you’ll spy the 
Calendars section, which works similarly to Contacts. 
On a Mac, you can sync all your iCal calendars or just 
selected calendars. On a Windows PC, you have these 
same options for Microsoft Outlook calendars.

Games (5G iPod, 3G and 4G iPod nano, and iPod 
classics only)

The iTunes Store sells not only applications for the 
iPhone and iPod touch through the App Store, but also 
games made specifically for click-wheel iPods. Current-
ly, The Store sells a small collection of games that are 
compatible with the 3G and 4G iPod nanos, iPod clas-
sics, and 5G iPod. Buy one of these games, and you can 
play it on any (or all) of these iPod models.

The Games pane is where you choose which games to 
sync to your iPod. Your choices are all games or selected 
games (chosen from a list of purchased games below).

Info (iPod touch only)

The Info tab is where you choose which data—contacts, 
calendars, mail accounts, and browser bookmarks—
you’d like to sync to your iPod touch. This tab is also 
where you configure iTunes to push email, calendars, 
contacts, and bookmarks from Apple’s MobileMe ser-
vice to the iPhone. I discuss these settings at length in 
Chapter 8.

Applications (iPod touch only)

Just as you can with the iPhone, you can install applica-
tions you’ve obtained from Apple’s App Store on your 
iPod touch. I look at the ins and outs of these applica-
tions in Chapter 6. For now, all you need to know is that 
in this tab, you can choose to sync all or just selected 
applications to your iPod touch.

Move Music to the iPod shuffle
As I mention earlier in the chapter, the iPod shuffle in-
teracts differently with iTunes compared with a display-
bearing iPod. To begin with, because the shuffle lacks 



Sonoma Valley Computer Group Newsletter	 34	 http://www.vom.com/svcg/index.html

a screen, it doesn’t need to offer options for synchroniz-
ing photos, videos, contacts, and calendars. The lack of 
a screen also means that you can do little to navigate a 
shuffle’s music library. You are, in a very real sense, fly-
ing blind.

Also consider the shuffle’s limited storage space. Because 
the current shuffles hold just 1 GB or 2 GB, you don’t 
have a lot of extra room for storing large music files. 
iTunes does its best to keep such files from being placed 
on your music player automatically.

With these limitations in mind, let’s take a look at just 
what iTunes offers for the shuffle owner.

When you attach an iPod shuffle to your Mac or PC, by 
default, iTunes launches. When it does, the shuffle ap-
pears in the iTunes Source list under the Devices head-
ing, just like any other iPod (save for the fact that its icon 
looks like a shuffle rather than a full-size iPod). Select 
that shuffle, and iTunes’ main window shows two tabs: 
Settings and Contents, with the Contents tab front and 
center.

Contents tab

In the top part of the window, you see a list of the tracks 
you’ve loaded on the shuffle. At the bottom of the win-
dow, you see the Autofill pane (Figure 4.16), which con-
tains the items described in the following sections.

 Figure 4.16 The iPod shuffle’s Con-
tents tab.

In theory, putting music on your shuffle is very simple. By 
default, iTunes is set up so that when you click the Au-
tofill button, iTunes grabs a collection of random tracks 
from your iTunes Library and copies those tracks to your 
shuffle. But things don’t have to work that way. Although 
the Autofill button, in league with the Autofill From pop-
up menu (which you’ll hear about in just a sec), is a pow-
erful way to move music to your shuffle, you need never 
touch it.

Blasphemy? Perhaps. But the only way to ensure that you 
get exactly the music you want on your shuffle is to lay 
off this button. Instead, if your shuffle has anything on it, 
select it, select all its contents, and press your computer’s 

Delete key. Then drag just the music you want from your 
iTunes Library onto the shuffle’s icon.

To see the order in which songs will play if the shuffle 
is set to play from beginning to end, click the number 
heading in iTunes’ main window. To save that playlist 
so that you don’t lose it when you later fill your shuffle 
with other music, select everything in the playlist, and 
choose File > New Playlist from Selection. A new playl-
ist will be created in iTunes’ Source list that includes all 
the selected tracks.

If you choose to bang the Autofill button, of course, it will 
do exactly what it says: fill your shuffle with as much as 
it can of the playlist selected in the Autofill From pop-up 
menu.

Autofill From pop-up menu

One way to customize your shuffle’s contents more care-
fully is to feed it from specific playlists. You might cre-
ate sets of music that make sense for particular activi-
ties—music for your next workout or for a car trip, for 
example. Or use a particular Genius playlist that appeals 
to you. When you’ve created these playlists, you can 
choose the one you like from the Autofill From pop-up 
menu.

Choose Items Randomly

The shuffle was designed with random play in mind, but 
you can make it load specific tracks in a specific order 
by disabling this option. When you do, iTunes takes the 
playlist selected in the Autofill From pop-up menu and 
places as much of it as can fit, in order, on the shuffle. 
When you’ve flipped your shuffle into “play from begin-
ning to end” mode, the playlist you load will play in that 
order. This technique is one way to ensure that the songs 
in an album you place on the shuffle play in the same 
order as they do on the album.

Choose Higher Rated Items More Often

I mean, honestly, what’s the use of putting music that 
you loathe on your shuffle? If you haven’t thought of a 
good reason for rating your audio files, now you have 
one. Assign a rating of four or five stars to your favorite 
tracks, and those tracks are more likely to be moved to 
your shuffle when this option is enabled.
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Replace All Items When Autofilling

When this option is selected, iTunes will wipe out what-
ever music the shuffle currently holds and replace it with 
selections from the playlist selected in the Autofill From 
pop-up menu. Leaving this box checked is a good way 
to help ensure that you get a fresh crop of music the 
next time you listen to your shuffle. It’s not such a good 
choice, however, if you want to keep some selections on 
the shuffle (podcasts, for example) and remove others.

Uncheck this option, and check Only Update Checked 
Songs in the Settings tab, and you’ve got a whole lot 
more control. This way, you can uncheck the tracks you 
want to keep on the shuffle and then click the Autofill 
button. The unchecked music stays put and is surrounded 
by new material.

Settings tab

The other tab you see when selecting an iPod shuffle in 
the Source list provides settings for formatting the little 
devil and managing its relationship with iTunes. The Set-
tings tab includes the some of the same options you find 
in a display-bearing iPod’s Summary pane.

At the top of the pane, you’ll find information regarding 
the shuffle’s name, capacity, software version number, 
and serial number.

Below is the same Version area that you see for other 
iPods. Here, you can update or restore your iPod with the 
latest iPod software.

The Options area is where the good stuff happens (Fig-
ure 4.17). Here, you’ll see options for launching iTunes 
when the shuffle is attached, updating only checked 
songs, converting higher-bit-rate songs to 128 Kbps 
AAC, enabling Sound Check, and enabling disk use.

 Figure 4.17 The Options area of 
the iPod shuffle’s Settings tab.

You’re familiar with some of these options already. Let’s 

look at the new ones.

Convert Higher Bit Rate Songs to 128 Kbps 
AAC

Although the shuffle can play uncompressed files (which 
I discuss earlier in the chapter), on a device with such 
limited storage, packing it with these large files isn’t 
such a good idea. Enabling this option instructs iTunes 
to slim down stout files so that they take up less space on 
the shuffle.

iTunes won’t automatically place Apple Lossless files on 
your shuffle; on the 1G shuffle, it also won’t load AIFF 
files. If you drag such files to the shuffle to place them on 
the player manually, however, iTunes will automatically 
convert them to 128 Kbps AAC files when this option is 
enabled. Your files will remain in their original format on 
your computer, but compressed copies will be made just 
for the shuffle.

Enable Sound Check

Enable this option, and your shuffle will use those Sound 
Check settings to play back tracks at a fairly consistent 
volume.

Limit Maximum Volume

Enable this option and adjust the slider to set a maximum 
volume for the shuffle. Click the Lock icon to password-
protect this option.

Enable Disk Use

If you enable this option, you can mount the shuffle on 
your computer and use it to store data files as well as 
music files.

To help ensure that you’ve got some room left for data 
files, iTunes includes a slider below this option that al-
lows you to determine how much of the shuffle’s storage 
space will be reserved for songs and how much will go 
toward data storage. If you set the slider to the halfway 
point on a 1 GB iPod shuffle, you can fit approximately 
120 4-minute 128 Kbps AAC songs and 512 MB of data 
on your iPod. Double those figures for a 2 GB shuffle.
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Tag, You’re It
So how does iTunes know about tracks, artists, albums, 
and genres? Through something called ID3 tags. ID3 
tags are just little bits of data included in a song file that 
tell programs like iTunes something about the file—not 
just the track’s name and the album it came from, but 
also the composer, the album track number, the year it 
was recorded, and whether it is part of a compilation.

These ID3 tags are the key to creating great Smart Playl-
ists. To view this information, select a track, and choose 
File > Get Info. Click the Info tab in the resulting win-
dow, and you’ll see fields for all kinds of things. You 
may find occasions when it’s helpful to change the in-
formation in these fields. If you have two versions of 
the same song—perhaps one is a studio recording and 
another is a live recording—you could change the title 
of the latter to include (Live).

A really useful field to edit is the Comments field. Here, 
you can enter anything you like and then use that entry 
to sort your music. If a particular track would be great to 
fall asleep to, for example, enter sleepy in the Comments 
field. Do likewise with similar tracks, and when you’re 
ready to hit the hay, create a Smart Playlist that includes 
“Comment is sleepy.” With this technique under your 
belt, you can create playlists that fit particular moods or 
situations, such as a playlist that gets you pumped up 
during a workout.

___________________________________________

Peachpit  
authors are all 
a-Twitter
You’ve probably already heard about Twitter. You may 
even be Twittering around yourself. But did you know 
that Peachpit and New Riders authors are Tweeting, 
too?

Peachpit’s super-cool authors have found yet another 
outlet for their endlessly flowing creative juices. But this 
one condenses their wisdom into easy-to-digest 140-
character bites.

If you’d like to see what our authors are up to, Twitter 
is your key to unlocking the magic.  Here are some of 
our brilliant authors who are actively swimming in the 
Twitter stream (You can also follow us @peachpit and 
@peachpittv!):
Aarron Walter: @aarron
Adam Engst: @adamengst
Andy Beach: @andybeach
Andy Clarke: @malarkey
Ben Waldie: @applescriptguru
Christopher Breen: @BodyofBreen
Christopher Schmitt: @teleject
Dave Awl: @DaveAwl
Dave Cross: @davecross
David Berman: @davidberman
David Blatner @dblatner
David duChemin: @Pixelatedimage
Dori Smith @dori
Dwight Silverman: @dsilverman
Eric A. Meyer: @meyerweb
Frederick V. Johnson: @frederickvan
Garr Reynolds: @presentationzen
Greg Rewis: @garazi
Jason Cranford Teague: @jason_speaking
Jeff Carlson: @jeffcarlson
Jeffrey Zeldman: @zeldman
Jeremy Keith: @adactio
Joshua Porter: @bokardo
Kimberly Blessing: @obiwankimberly
Kris Hadlock: @khadlock
Maria Langer: @mlanger
Mark Christiansen: @flowseeker
Meryl K. Evans: @merylkevans
Miraz Jordan: @miraz
Molly Holzschlag: @mollydotcom
Mordy Golding: @Mordy
Peter-Paul Koch: @ppk
Robert Hoekman, Jr: @rhjr
Scott Kelby: @ScottKelby
Scott McNulty: @blankbaby
Stephanie Sullivan: @stefsull
Stu Maschwitz: @5tu
Susan Weinschenk: @susanweinschenk
Tom Negrino: @negrino
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Mac Tip of the 
Week #220
Excerpted from The Little Mac Book, 	
Leopard Edition 
by Robin Williams

Enlarge Screen Items for	
Better Visibility
If you want everything on your Mac screen to appear 
larger, go to the Apple menu and choose System Prefer-
ences. In the Hardware section of the System Preferenc-
es window, click the Displays icon and choose a lower-
numbered resolution.

Speed up iPhoto 
‘09 operations 
on some Macs
by Rob Griffiths, Macworld.com

If you’re trying to use iPho-
to ’09 on older pre-Intel 
hardware and/or if you have 
a very large photo library, 
you may have noticed that 
many face-related opera-
tions, such as tagging and 
drag-selecting, take an in-

ordinate amount of time. During these delays, iPhoto 
may appear to be locked, or you may be treated to the 
wonderful spinning beachball cursor show while iPhoto 
thinks about what you’ve just asked it to do.

Short of ordering a eight-core Mac Pro with 32GB of 
RAM, I’m afraid I don’t have an iron-clad solution to 
this problem. I do however, thanks to Mac OS X Hints 
contributors Chris Devers and Brian Hagemann, have a 
suggested fix that may reduce the delays.

When you look at your albums and libraries in the left-
hand pane in iPhoto, do you see photo counts next to 

each one? While these little numbers may prove useful, 
they may also be somewhat responsible for the slow-
downs you’re experiencing. The task of updating these 
counts whenever you modify your images appears to 
cause iPhoto to slow down, at least for some users.

To disable the item counts, open iPhoto’s preferences, 
and on the General tab, uncheck the ‘Show item counts’ 
box. (On my machine, toggling this checkbox sometimes 
seems to take a few seconds, so don’t go click-crazy if it 
seems like it’s not working.)

After disabling the photo counts, try tagging some faces 
and see if the slowdowns have disappeared—or at least 
been reduced to bearable levels. For both Chris and Bri-
an, this simple change made a huge difference. On my 
Mac Pro with a 17,000ish photo library, the change isn’t 
really noticeable. But if you’re experiencing slowdowns 
in faces and use photo counts, it might be worth disabling 
them to see if it makes a difference.

Mac 101: Using 
Time Machine 
in Mac OS X 10.5 
Leopard 
Summary

Did you ever wish there was a re-
ally easy and safe way to let your 
Mac perform backups for you? 
Time Machine, included with Mac 
OS X 10.5 Leopard, is the answer. 
More than just a backup utility, 
Time Machine makes an up-to-date 
copy of everything on your Mac--

digital photos, music, movies, downloaded TV shows, 
and documents—and lets you easily go “back in time” 
to recover files.

Getting started

The first time you attach an external drive to your Mac 
OS X Leopard-based Mac, Time Machine asks if you’d 
like to use that drive as your backup location (you may 



Sonoma Valley Computer Group Newsletter	 38	 http://www.vom.com/svcg/index.html

need to erase the drive first). Choose yes and Time Ma-
chine takes care of everything else, automatically, in the 
background. You won’t have to worry about backing up 
again.

Customizing Time Machine

You can easily customize Time Machine or change back 
up locations. First, open Time Machine preferences:

   1. Choose System Preferences from the Apple Menu.
   2. Click the Time Machine icon.
    3. If you’ve never turned Time Machine on before, 
you’ll be asked if you want to turn it on.

Changing your backup location

   1. Click Choose Backup Disk, then select the disk to 
save backups to.
   2. Click Change Disk, and from the listing in the re-
sulting dialog select a new disk to use for backups, and 
click Use for Backup to save the new location.

Adjusting what Time Machine backs up

If you want to minimize backup storage space, or just 
limit your backups to certain data, you can exclude cer-
tain files and folder from Time Machine backups.

   1. In Time Machine preferences, Choose Backup Disk, 
then click Options. A list of locations that are backed up 
appears.
   2. To add a new “do not back up” location to the list-
ing, click the “+” button below the list, navigate to the 
location you want to exclude and click Exclude.
      To delete a listing, select that listing and click the 
“-” button.
   3. Click Done to return to Time Machine preferenc-
es.
     4. Drag the Time Machine OFF-ON slider to turn 
Time Machine on or off.

Now that Time Machine is setup, you can forget about 
it until you need to restore files, folders, or even your 
entire system! Time Machine will continue making au-
tomatic backups for every hour of the last 24 hours, ev-
ery day of the last month, and every week past that until 
your backup disk is full.

Recovering files or folders with Time Machine

If you lose or accidentally delete a file or folder, and 
you’ve been using Time Machine to back up your com-
puter, the fastest way to recover your missing item is to 
use Time Machine and Spotlight together.

To easily restore a particular file, first use Spotlight to 
specify the file or folder location you need to recover. 
For example, if you need to recover a presentation on 
architecture, search for “architecture” using Spotlight.

Once you’ve located the file you want to restore, (or a 
file you want to restore even if Spotlight can’t find it), 
click the Time Machine icon in the Dock. Spotlight will 
pass your search to Time Machine.

In the Time Machine “time travel” window, use the 
large arrows to the right of the search window, or the 
timeline on the right window edge of Time Machine, to 
browse through your backups. Your previous search is 
performed in every backup window as it is displayed.

When you’ve found the file you want, select it and use 
Quick Look to make sure.

Click Restore to restore the file. The restored item is 
returned to its original location. For example, if the file 
was in the Documents folder, it is returned to the Docu-
ments folder.

Time Machine may ask if you want to re-create one or 
more folders in order to return a restored item to its orig-
inal location.

Besides restoring deleted files, Time Machine can re-
store previous versions of an existing file. For example, 
if you made changes to a really important presentation, 
then accidentally saved unwanted changes to the origi-
nal file, Time Machine can restore the previous version, 
and preserve the current version too
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how can i make 
my cursor  
bigger
Apple Prefs> Universal Access> Mouse> Cursor Size

Mac Tip of the 
Week #221
Excerpted from Mac OS X 10.5 Leopard: Visual Quick-
Start Guide by Maria Langer

Labels
Mac OS X’s Labels feature enables you to assign col-
or-coded labels to Finder icons. You can then sort list 
view windows by label or search for items based on the 

assigned label. To assign a label to an item, go to the 
Finder window and select the icon(s) you want to apply 
a label to. From the File menu, choose the color of the 
label you want to apply.

Software Up-
dates - Tips and 
Tricks
By Matt Klein	
Smalldog.com

Every now and again, 
Apple releases software 
updates to all Mac us-
ers. It’s rare now to see 
updates for 10.3 and 
earlier, but they do pop 
up now and again. It is 
generally safe and rec-
ommended that you in-
stall each of the updates 
as they become available, and it’s generally a good idea 
to install all of the updates instead of selecting updates 
only for the software you use. For example, an update 
to Safari can affect function of the iTunes store.

Huh?

Part of the underpinnings of Mac OS X are frameworks, 
or shared resources. Without writing a novel, think of 
frameworks as sections of the operating system that any 
program can draw on. I mentioned that a Safari update 
can affect iTunes, because the HTML rendering engine, 
WebKit, is what renders web pages in Safari and the 
content you see in the iTunes Music Store.

There are a few reasons that software updates fail. 
Among them is a slow or otherwise finicky internet 
connection. If your computer is trying to download a 
large update, but stalls, the Apple server sending the 
update to you will think you were disconnected after 
a short while. This is often referred to as a “timeout 
error,” and is sometimes accompanied by an error mes-
sage that says “Make sure you can connect to the Inter-
net, then try again.”
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I sometimes hear from customers who see this error mes-
sage. The fix, 99% of the time, is to just reset both your 
AirPort Base Station (or similar by another manufacturer 
like Netgear or Linksys) and your cable, DSL, or satel-
lite modem. Whenever resetting these devices, it’s best to 
leave them unplugged for about ten minutes to dissipate 
any residual electricity stored in capacitors.

After ten minutes, plug the devices back in. A few min-
utes later, your computer(s) will recognize your network 
and should be re-connected to the web. Your software up-
dates should download just fine now.

If, for some reason, they do not download successfully, 
it may be due to extraordinary network traffic on Apple’s 
servers, like that occurring after the release of a major up-
date like 10.5.7, released just the other day at over seven 
hundred megabytes for some users!

MAC TREAT #85: 

Password-Protect Your iWork Docs
By Kali Hilke
Smalldog.com

In iWork ’09, I use 
Pages most often, then 
Keynote, and finally, 
Numbers. 

I was recently remind-
ed of the benefits of 
password protection 
when Ed and I present-
ed our departmental review in Keynote to other depart-
ment managers today at Small Dog, and I wanted to keep 
the presentation Top Secret.

 To create a password-protected document in iWork ’09, 
click on the Inspector (the blue “I” universally featured 
across iWork and other Apple applications) and go to 
the Documents section (usually the first category in the 
Inspector) and check Require Password to Open. It will 
then prompt you to set up a password, verify and set a 
hint (optional).

Next week, I’ll elaborate on the features of Keynote in 
“How to Use Keynote Like Steve Jobs” (Or Phil Schiller, 
as the case may be at the upcoming WWDC event)!

addressbook 
and ical
Reader Peter Frank questions Apple’s devotion to se-
nior citizens. He writes: “I use Address Book and iCal, 
which sync to my iPhone very nicely except for birth-
days of people over about 76 years of age. Anyone born 
before 1/1/1933 (for this year) does not get their birth-
day synced over to the iPhone. Why is this and is there 
any way to fix it? Each year my family and friends get 
older and some are over this arbitrary cut off.”

Allow me to outline what’s happening here. In Address 
Book you’ve caused the Birthday field to appear by 
opening Address Book’s preferences, clicking the Tem-
plate tab, and, from the Add Field pop-up menu, select-
ing Birthday. In Address Book, you then entered birth 
dates for your nearest and dearest.

You then launched iCal, opened its preferences, and en-
abled the Show Birthdays Calendar option in the Gener-
al tab. You then browsed through iCal and, sure enough, 
there were the birthdays you’d added in Address Book.

Good so far. Now, when you synced your iPhone to 
this birthdays calendar you discovered that those of ad-
vanced years did not appear on your iPhone. The rea-
son is that the iPhone and iPod touch are limited to re-
peating a single event just 75 times. Regrettably, your 
iPhone doesn’t see Aunt Toni’s 76th birthday through 
sentimental eyes. To it, she’s just an event that’s repeat-
ed one time too many.

The solution is to create a separate repeating event in a 
different iCal calendar for your well-seasoned friends 
and family members that begins this year. Unless they 
live to be more than 150 years old, you should be set.
- Christopher Breen



streets in search of open networks will find AirRadar a 
handy ally. And on a less shady note, wireless network 
administrators can use the program to probe for weak or 
slow routers in their buildings or campuses.

A signal-to-noise graph lets you track a giv-
en network’s performance over time.

For a $10 app, AirRadar is admirably polished and pro-
fessional. A thorough Preferences window lets you cus-
tomize pretty much everything, from the goofy sounds 
the program plays whenever its scan registers a new net-
work to the colors of the graphs. The program’s Help 

menu is simple but effective, with plenty of useful 
information.

Admittedly, using a program that digs up so much 
information about the networks around you feels a 
little creepy and intrusive. I’d advise using it respect-
fully and responsibly. But aside from the spy factor, 
AirRadar is a terrific little program, well made and 
well worth the $10 from wireless buffs.

Want to stay up-to-date with the latest Gems? Sign up 
for the Mac Gems newsletter for a weekly e-mail sum-
mary of Gems reviews sent directly to your inbox.

[Nathan Alderman is a writer, copy editor, and Wi-Fi 
addict in Alexandria, Va.]
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AirRadar 
surveys your 
wireless signals
by Nathan Alderman, Macworld.com

[Editor’s note: The following re-
view is part of Macworld’s Gem-
Fest 2009 series. Every day until 
the end of June 2009, the Macworld 
staff will use the Mac Gems blog to 
briefly cover a favorite free or low-

cost program. Visit the Mac Gems homepage for a list of 
past Mac Gems.]

Increasingly, the airwaves around us are a jungle of com-
peting wireless signals. Koingo Software’s AirRadar   not 
only helps cut through the clutter, but also provides use-
ful information about your wireless signal of choice.

AirRadar quickly scans for surrounding wire-
less networks, pulling in a wealth of customiz-
able information about them.

AirRadar seems designed for users serious about their 
wireless safaris. It scans for available networks, display-
ing highly detailed information about their MAC address-
es, broadcast channels, signal strengths, and numerous 
other categories only a network administrator could love. 
Users can easily add networks to a list of favorites, or 
filter them out of the main scan list. You can also pull up 
a graph of a given network’s signal-to-noise ratio, which 
the program tracks and compiles over time. You can even 
tell AirRadar to automatically find and join the nearest 
open network above a specified signal strength.

If you’re an ordinary Joe Wi-Fi type like me, you can see 
how your network signal is holding up, and whether it’s 
on the same channel as competing networks that might 
be interfering with its reliability. Wardrivers roving the 



Sonoma Valley Computer Group Newsletter	 42	 http://www.vom.com/svcg/index.html

Our Take On A Java 
Vulnerability on 
Mac OS X
By Morgan Aldridge
Smalldog.com

Word is spreading that there’s a critical security vulnerability in 
Java on Mac OS X. Actually, it’s a couple of vulnerabilities that can 
be taken advantage of to run commands outside of the browser as 
the user that launched the browser. The truth is that it’s been known 
about since at least August of last year and Sun, the makers of Java, 
fixed it long ago, but those fixes haven’t made it into Mac OS X yet, 
not even the 10.5.7 update.

So, what’s a Mac User to do? There’s no known use of exploit be-
yond the proof-of-concept examples, but the triage is pretty sim-
ple:

1. Turn off ‘Open “safe” files after downloading’ in Safari -> Pref-
erences -> General
2. Turn off Java in Safari -> Preferences -> Security and any other 
browsers you use

This will prevent malicious Java code on a web page or downloaded 
from running automatically. There’s no reason to panic and JavaS-
cript will still function normally, but it’s better to be on the safe side 
if you’re not regularly visiting web sites requiring Java.

___________

“MUCH TODO ABOUT NOTHING”

___________

[Op. Ed. - Kathy Aanestad]
Recently, I had a conversation with some techy friends about some 
comments relating to the Mac vulnerability to malware attacks and 
following are some of their opinions. 

“Please show me *evidence* of Macs being successfully attacked 
in the wild. Questions you should ask when you hear such reports:

A) How many Macs have been successfully compromised?

B) How many of those were compromised completely without the 
owner’s knowledge or participation? Typically exploits for Mac 
OS X require a user to enter their administrator password some-

where, for example.

C) How many required direct user partici-
pation (i.e. entering an administrator pass-
word) and how was the user thus duped?”

“It’s not to  say there isn’t anything to 
worry about, but  for 99.9+% of Mac users 
out there, there is nothing to worry about. 
Until I see real evidence to the contrary I’ll 
spend more time worrying about being hit 
by a meteor than having my laptop infected 
with any malware.”

“The phrase “run roughshod all over OS 
X.” What does that mean?

“The day will probably eventually come 
when Macs will become subject to some 
serious and legitimate attack. I just haven’t 
seen it yet.”

“To those people who speak about Mac at-
tacks, please point to the specific article and 
reference to be a supportable argument and 
not be hearsay. I did a search and did not 
come up with any of those phrases or any 
more advisories other than the two known 
social engineered malware hacks that are 
out there. One is the Java vulnerability 
and the other is the DNSchanger that has 
been out for more than 6 months and takes 
a download of untrusted software from 
untrusted sites.”
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Mac Tip of the 
Week #222
Excerpted from Apple Training Series: iLife ‘09

by Michael E. Cohen et al.

Publishing Your 
Movie to	
Apple Devices
To create a movie that can be played on Apple devices or 
any computer using iTunes, use the Share to iTunes com-
mand. With your movie open, choose Share > iTunes. A 
dialog opens, asking which size you would like to publish. 
The dots beneath each icon in the dialog identify which 
sizes are suitable for which target device (iPod, iPhone, 
Apple TV, or computer). The numbers at right indicate 
the video’s dimensions (width x height) in pixels. If your 
original media isn’t large enough to render in any of these 
sizes, those options will be dimmed. If you select both the 
Tiny and Medium options, your movie will be viewable 
on all three of the Apple devices, as well as on full-size 
computers.

Mac 911 Tip of 
the Week
Reformatting Flash Drives
Reader Dan Coates believes in recycling (or, at least, re-
formatting). He writes: “I have a number of commercial 
flash drives with outdated information. How can I unlock 
them for reuse?”

Increasingly, companies are putting data on cheap USB 
flash drives and passing them along to customers and col-
leagues. Like you, I agree that it’s a shame to toss them 
out when you can easily reformat them and put them to 
use for your own purposes. The easiest way to reformat 
one of these things is to launch Disk Utility (Applications/

Utilities), select the flash drive from Disk Utility’s list 
of drives, click the Erase tab, choose MS-DOS (FAT) 
from the Volume Format pop-up menu, and click the 
Erase button. The drive will be erased with the selected 
format and will be usable on both Macs and Windows 
PCs.

I’ve seen claims on the Internet that formatting these 
drives in the Mac OS Extended (Journaled) format 
speeds up transfers. I haven’t found that to be the case. 
In fact, when copying a 2GB folder to a SanDisk U3 
Cruzer Micro USB flash drive I found the opposite to 
be true. It took 7 minutes and 42 seconds to copy the 
folder to the drive when it was formatted using MS-
DOS (FAT) and 8 minutes and 27 seconds when the 
drive was formatted using OS X Extended (Journaled). 
When copying that same folder from the flash drive to 
my hard drive the two were close -- 1 minute 36 sec-
onds for the OS X Extended format and 1 minute and 
40 seconds for the MS-DOS format.

Should you desire to format the drive as Mac OS X 
Extended (Journaled), you’re welcome to. To do so, 
select the drive in Disk Utility, click the Partition tab, 
select 1 Partition from the Volume Scheme pop-up 
menu, click the Options button, choose GUID Parti-
tion Table or Apple Partition Map from the resulting 
sheet (GUID for Intel Macs or any Mac running 10.4 
or later or Apple Partition Map for PowerPC Macs run-
ning any version of Mac OS X), and click OK. Choose 
Mac OS Extended (Journaled) from the Format pop-
up menu and click the Apply button. In the sheet that 
appears click the Partition button and your flash drive 
will be formatted as a Mac OS X Extended (Journaled) 
drive.
- Christopher Breen
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